
1, 2, ... commands (Window menu)

SuperForms displays a list of currently open form windows at the bottom of the Window menu. A
check mark appears in front of the form name of the active window. Choose a form from this list 
to make its window active.



1, 2, 3, 4 commands (File menu)

Numbers and file names listed near the bottom of the File menu list the last four forms you 
opened. Choose the number that corresponds to the form you want to open, or click on the 
name with the left mouse button.



About command (Help menu)

Displays the copyright notice and version number of your copy of SuperForms™.

SuperForms™    is    © 1996 by EZX Corporation, all USA and International 
rights reserved.

Distributed by:
EZX Corporation / SuperSoftWare
“The SuperForms Automation Company”
403 E. NASA Rd., Suite 377
PO Box 58177    -    SPF96f
Webster (Houston), TX    77598-8177    USA

Credit Card Orders (Visa, MasterCard, Discover, American Express) may call the 
ORDER DESK @ 1.800.713.2468 ext.SPF96f (toll free in the USA)
(There is a per-minute charge for service/support calls to the above number.)

Technical Support:
Voice: +1-713-280-0080 (9:00am - 4:00pm    Central    USA    M - F)
EZ-Host! BBS: +1-713-280-8180 (E-mail; Support, etc. 24hrs. per day)
Internet: ezx@cris.com    or    EZXHOU@aol.com
AmericaOnLine: EZXHOU (E-mail)
CompuServe: 76350,3111 (E-mail)
World Wide Web: http://www.cris.com/~ezx

or    http://home.aol.com/EZXHOU

For all other business and International:
Voice: +1-713-280-9900 (Questions, Comments, observations, & 

support.)
FAX: +1-713-280-0099 (Inbound FAXes; 24hrs per day.)



!(Note, our Area Code may change to 281 around
 Nov. 3, 1996. If 713 or 281 do not get through,
 dial 713-555-1212 and ask for EZX Corporation's
 phone number and area code. Thank-you Texas PUC?)



Arrange Icons command (Window menu)

Use this command to arrange icons for minimized windows at the bottom of the SuperForms 
main window. If there is an open form window covering the bottom of the main window, then 
some or all of the icons may not be visible because they will be behind this form window.



Brush command (Form menu)

Modify background/fill attributes for the selected object by using the Brush command in the 
Form menu or the object popup menu. This displays the Brush dialog box.



Brush command (Options-Defaults menu)

The settings assigned in the Options-Defaults-Brush dialog box are used to set defaults for all 
newly created rectangle, rounded rectangle and ellipse objects. Existing objects are unaffected.

All options are saved into the .INI file with the Options-Save Settings command.



Brush Dialog

Choose the background fill pattern and color for Rectangle, Rounded Rectangle and Ellipse 
objects. When accessed with the Options-Defaults-Brush menu, brush selections will only affect
newly created objects.

The brush characteristics of an object can be altered after placement by using the Form Brush 
command, accessible from the main menu or the object popup menu. The dialog box title will 
not include "Defaults" when modifying an existing object.

Style:
Available fill pattern design and shading effects for shaped objects are:
Cross Hatch
Diagonal Cross
Downward Hatch
Horizontal Hatch
Solid
Transparent
Upward Hatch
Vertical Hatch

Brush Color button
Access the Color dialog to choose from a given color set.



Cascade command (Window menu)

Use this command to arrange multiple open windows in an overlapped fashion.



Clear All (Edit menu)

Design Mode
This provides a quick and convenient way to clear all objects in a form. Prompts for confirmation
first. The resulting form is blank, identical to the blank form created by the Form-New command.

Fillout Mode
This provides a quick and convenient way to clear the contents of all fields in a form. Prompts 
for confirmation first. The resulting form has all blank fields.



Close command (Control menus)

Use this command to close the active window or dialog box.
Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open, the Close command on the form Control menu 
closes only one window at a time. You can close all windows at once with the Close-All 
command in the Window menu.

Shortcut
Keys: Ctrl + F4 Close a form window.

Alt + F4 Close a dialog box



Close command (File menu)

Use this command to close an active form window. When the form is modified, a save 
prompt will appear. If you close a modified form without saving it, you lose all changes 
made since the last time you saved it. Before closing an untitled form, SuperForms 
displays the Save As dialog box and suggests that you name and save the form.

You can also close a form by double-clicking the Close icon on the form's window, as 
shown below:



Close All command (Window menu)

Use this command to close all open windows including those that have been iconized. You will 
be asked if you want to save any unsaved forms before closing them.



Color Dialog

Use this dialog box to add color to your form's text, lines, boxes, etc.

Basic Colors
The current color selection is indicated by the shadowed box.
To select a new color, click on the color with the mouse or move the shadowed box with the 
arrow keys.

Custom Colors
This feature is unsupported by SuperForms.
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Thank you for using SuperForms™ for Windows © 1996 by and from:    (All rights 
reserved.)

EZX Corporation / SuperSoftWare
“The SuperForms Automation Company”
403 E. NASA Rd., Suite 377
PO Box 58177    -    SPF96f
Webster (Houston), TX    77598-8177    USA

Technical Support:
Voice: +1-713-280-0080 (9:00am - 4:00pm    Central    USA    M - F)
EZ-Host! BBS: +1-713-280-8180 (E-mail; Support, etc. 24hrs. per day)
Internet: ezx@cris.com    or    EZXHOU@aol.com
AmericaOnLine: EZXHOU (E-mail)
CompuServe: 76350,3111 (E-mail)
World Wide Web: http://www.cris.com/~ezx

or    http://home.aol.com/EZXHOU

For all other business and International:
Voice: +1-713-280-9900 (Questions, Comments, observations, & 

support.)
FAX: +1-713-280-0099 (Inbound FAXes; 24hrs per day.)

For more information, contact EZX Corporation at 713-280-9900    FAX: 713-280-0099.



!(Note, our Area Code may change to 281 around
 Nov. 3, 1996. If 713 or 281 do not get through,
 dial 713-555-1212 and ask for EZX Corporation's
 phone number and area code. Thank-you Texas PUC?)

Special versions of FormPower/FillPower specifically tied to custom developed forms, are the 
“engines” that drive products like ExportPower™, PackageTrakker™, YourForms PRO™, 
WinDD250™, WinSF171™, AnyPower™, MedPower™, ExpensePower™, etc. Call for details.

Should you require a special “sub-published” edition of FormPower/FillPower customized for 
you and your special form or application, contact EZX at the address and numbers above. 
Developers and VARs only, please.

Thank you for using SuperForms™ for Windows © 1996 by and from:    (All rights reserved.)

Call for Multi-user, LAN, Server, Site, Regional and Corporate licensing.

Ask about upgrade, competitive, and introductory pricing.

Also ask about custom design and “sub-publishing” services.

Specifications, pricing, etc. are subject to change without notice.

Copyright © 1996 EZX. 960422 All rights reserved.



Control menu (Form window)

The main SuperForms window and the Form and Dialog box windows all have a control menu 
tab in the top left corner. Double-clicking on the tab is the same as selecting Close from the 
menu.

Restore Restores the window.
Move Repositions the window.
Size Adjust the window size.

Minimize Iconize the window.
Maximize Expand the window.

Close Closes the window.
Next From control tab.

Switch to another open form within SuperForms.



Control menu (Main window)

Top Left tab on Program, Form and Dialog box windows. Double-clicking on the tab is the same 
as selecting Close from the menu. Double-click on the Control tab, or use key combination Alt + 
F4 to close the program window, or any displayed dialog boxes.

Restore Restores the window.
Move Repositions the window.
Size Adjust the window size.

Minimize Iconize the window.
Maximize Expand the window.

Close Closes the window.
Switch To Program control tab.

Switches to another program.



Copy command (Edit menu)

Use this command to copy the currently selected (highlighted) object or text from the form and 
put it into Windows' clipboard. The Paste command can then be used to copy the clipboard 
contents to another form, or to elsewhere on the same form.

This command is unavailable if no object or text is selected.

Copying data to the Windows clipboard always replaces any previously stored contents.

Shortcut
Toolbar:
Keys: Ctrl + C



Creating icons for your forms.
(Tutorial not available with SuperForms, ask about FormPower PRO.)

See Lesson 19 in the Tutorial Help file for instructions on setting up forms you've designed to be
launched from their own group and individual icons.



Cut command (Edit menu)

Use this command to remove the currently selected (highlighted) object or text from the form 
and put it into Windows' clipboard. The Paste command can then be used to copy the clipboard 
contents to another form, or to elsewhere on the same form.

This command is unavailable if no object or text is selected.

Cutting data to Windows' clipboard always replaces any previously stored contents.

Shortcut
Toolbar:
Keys: Ctrl + X



Text Feed-Date (Edit menu) & Date (Field menu)

Quickly insert system Date into a field during data entry using Ctrl + D. Any text that may 
already be in the field will be overwritten. You will not be able to insert into the middle of a 
sentence or phrase.

The format for Text Feed Date is controlled by the Windows' Control Panel International 
settings.

Shortcut
Toolbar:
 Keys: Ctrl + D



Delete Command (Edit menu)

Use the Del key, or the Edit-Delete command to delete the currently selected object from the 
form.

While entering text in design mode or during fillout mode, this command will delete selected text
or the character to the right of the cursor.



Design Mode Overview
Click on an area of the dialog box for further explanation.



Ellipse command (Draw menu)

Ellipse Drawing tool. Activate by clicking on the Ellipse Toolbar button, or by selecting the Draw-
Ellipse command.

1) Position the mouse pointer to where you want to begin drawing.
2) Press and hold the left mouse button while dragging the mouse, thereby drawing an ellipse to
the desired size.
3) Release the mouse button when done.

When the Snap-to-Grid option is selected in the Grid dialog box, the encompassing rectangle's 
corner points will "snap" to the nearest grid points.

See Also

Modifying Object Attributes and Moving and Resizing Objects

Shortcut
Toolbar:



Error and Warning Messages
Select one of the following error or warning message topics. Each will specify whether it applies 
to design mode, fillout mode, or both. Where possible, remedies are given.

Server is still busy.

There are no fields in this form. Fillout cancelled.

Save option settings?

Save this form before continuing.

Are you sure you want to clear the entire form?

Cut to clipboard failed.

Copy to clipboard failed.

Failed to paste object from clipboard.

Failed to create object.

Item on the clipboard has zero size.

Failed to initialize OLE2 libraries.

Error loading EZX1.DLL

Error opening graphic file

This single-user version of FormPower cannot access network drives. Please contact EZX for 
network pricing information.

This single-user version of FormPower cannot run from a network drive. Please contact EZX for 
network pricing information.

Error setting system timer.

The FormPower executable file exhibits evidence of tampering. Unable to continue. Reinstall 
from original disks.

Please enter a number between .02 and 25.4 cm.

Please enter a number between .05 and 2.54 cm.

Please enter a number between 5.08 and 76.2 cm.

The form orientation does not match the printer orientation setting. Continue printing?

Invalid date value.



Linking to a graphic file will only save the file path name in the form.    This requires ...

Error creating graphic file ?.

Error drawing graphic.    The original image is ...

Unable to find the linked graphic file ?.    If this form was copied ...

Unable to find the linked graphic file ?.    If this form was copied ...

Error updating OLE object from server.    Possible out of memory condition.



Error creating graphic file ?.
Design mode

A system error occurred when creating the file that a graphic is to be written to.

Remedy

Check the following possibilities:
1) Too many files in the destination directory.
2) No creation rights for directory, if network drive.
3) Insufficient system file handles.



Error drawing graphic. The original image is ...
Image complexity or size is preventing proper display.

Remedies

Convert graphic to black and white, if not already.

Close other applications.

Convert graphic to a smaller size.



Error loading EZX1.DLL
This file is required for the operation of SuperForms. It should be located in your SuperForms 
subdirectory.

See Installation for a listing of program files required by SuperForms.



Error opening graphic file
File format may not be supported by Windows or SuperForms. If accessing file over a network, 
it may be in exclusive or restricted use by another client.



Error reading graphic file
File format may not be supported by Windows or SuperForms. If accessing file over a network, 
it may be in exclusive or restricted use by another client.



Error setting system timer.
Windows has apparently lost critical synchronization. Please save and close all applications, as 
well as Windows.

Remedy

Reboot your computer and restart Windows.



Error updating OLE object from server.    Possible out of 
memory condition.
Unable to complete and OLE object insert or display.

Remedies

Close other applications.

Reinstall OLE server application.



Copy to clipboard failed.
There may be too many open programs in Windows to complete the action. System resources 
may be low.

Remedy

Try shutting down some applications and then retry this action.



Cut to clipboard failed.
There may be too many open programs in Windows to complete the action. System resources 
may be low.

Remedy

Try shutting down some applications and then retry this action.



A field with this name already exists. Field names must be 
unique.
Design mode

Some other field in this form already has this name. Field names must be unique in order to 
ensure unambiguous calculations and validations.



The FormPower executable file exhibits evidence of 
tampering. Unable to continue. Reinstall from original 
disks.
This error could occur after a system crash, unexpected power interruption, compression 
corruption, software virus attack, as well as many other sources. The program is no longer 
usable and must be reinstalled. The executable file has been corrupted. Copy your master 
forms (.FRM) and filled out forms (.FOF) to a secure floppy. Remove the SuperForms icons and 
group from Windows. Delete all other files relating to SuperForms. Then reinstall.

When reinstalling SuperForms, make sure the distribution disks are write protected. If a virus is 
suspected, run one of the many available anti-virus programs for a diagnosis.

Note: All EZX/SSW programs are virus free when shipped from EZX. As we have no control of 
their handling after leaving EZX, we disclaim all responsibility for same.



Failed to create object.
Design mode

The object type may not be assigned in the Windows registry profile (REG.DAT). You may need 
to edit the REG.DAT file via the Windows program REGEDIT.EXE.

Remedy

Reinstall the application needed to create the object you need.

Or, use REGEDIT.EXE to verify proper entries for this object type. Refer to Windows technical 
documentation.

Caution: Consult an experienced Windows user or consultant before attempting this. 
SuperForms automatically installs itself in the registry with the installation routines provided on 
the distribution disks. If you did not use the INSTALL program provided with SuperForms, the 
registry will not have been updated. Reinstall the proper way. Other programs may not 
automatically update the registry. Consult their respective publishers or distributors for help.



Failed to initialize OLE2 libraries.
Appropriate object linking and embedding files are not available.

Remedies

1) Look for multiple copies of any .dll file that start with "ole". There should only be one copy of 
any particular ole file on your system. Look in both your windows and windows\system 
directories for duplicate ole files. All ole*.dll files should be in the windows\system directory only.
If you are still experiencing this problem, continuing looking for duplicate dll's in directories 
specified in your DOS PATH environment variable.

2) Reinstall the application.



Failed to paste object from clipboard.
There may be too many open programs in Windows to complete the action. System resources 
may be low.

Remedy

Try shutting down some applications and then retry this action.



Invalid date value.
When entering dates, the format must match what was specified in the Windows International 
Settings. These can be viewed or modified via the Windows Control Panel.

This error will also result when an invalid day, month or year is specified.



Item on the clipboard has zero size.
The contents of the clipboard has been corrupted.

Remedy

Try pasting the original again. Make sure there are no programs running that deal with intensive 
tasks such as a spreadsheet recalculation, or image rendering. Processes that use a lot of 
computer or Windows system resources may restrict other program operations.



Linking to a graphic file will only save the file path name in 
the form.    This requires ...
A choice must be made that affects how a graphic placed in the form. There are two 
possibilities.

See Also

Edit Insert Graphic



Please enter a number between .02 and 25.4 cm.
Design mode

You must enter the number within the given range.



Please enter a number between .05 and 2.54 cm.
Design mode

You must enter the number within the given range.



Please enter a number between 5.08 and 76.2 cm.
Design mode

You must enter the number within the given range.



This single-user version of FormPower cannot access 
network drives. Please contact EZX/SSW for details on 
the network versions of FormPower and pricing 
information.
Please contact EZX/SSW at 1.713.280.9900 (FAX: 1.713.280.0099) with your requirements, 
and we will forward a custom quotation addressing your particular network needs.



This single-user version of FormPower cannot run from a 
network drive. Please contact EZX/SSW for details on the 
network versions of FormPower and pricing information.
Please contact EZX/SSW at 1.713.280.9900 (FAX: 1.713.280.0099) with your requirements, 
and we will forward a custom quotation addressing your particular network needs.



Server is still busy.
SuperForms is currently processing an OLE function and the attempted operation is 
unsupported in this mode.

Remedy

Wait for the OLE function to complete.



The graphic image is too large.
Image complexity or size is preventing proper display.

Remedies

Convert graphic to black and white, if not already.

Close other applications.

Convert graphic to a smaller size.



There are no fields in this form. Fillout cancelled.
Design mode

To fill out a master form, it must either be loaded with the File Fillout command or converted by 
using the Edit Fillout command. In either case, if no fillout fields exist in the master form, fillout 
cannot proceed and this message will result.

Remedy

Use the Field drawing tool to create fields on the form.



Unable to find the linked graphic file ?.    If this form was 
copied ...
When a form is opened, all linked graphic files must be accessible. If the graphic originally 
resided in a directory other than where the form was saved, then the graphic file name in the 
form will include the entire path to the form, i.e., it will include the directory and file names.

Remedies

- Verify that graphic files reside in original locations
- Edit the master form and change the graphic file or location



Exit command (File menu)

Use this command to end your SuperForms session. You can also use the Close command on 
the SuperForms Control menu. SuperForms prompts you to save forms with unsaved changes.

Shortcut
Mouse: Double-click SuperForms' Control menu button.



Field command (Draw menu)

Field Drawing tool. Activate by clicking on the Field Toolbar button, or by selecting the Draw-
Field command.

1) Position the mouse pointer to where you want to begin drawing.
2) Press and hold the left mouse button while dragging the mouse, thereby drawing a rectangle 
to the desired size of the field.
3) Release the mouse button when done.

Height of the field is fixed to a multiple of the selected font height. When changing a font, be 
sure to also readjust the height of the field.

When the Snap-to-Grid option is selected in the Grid dialog box, the encompassing rectangle's 
corner points will "snap" to the nearest grid points.

You may begin creating data entry fields at any time during Master Form design.

Fillout Field Order

When a form is filled out, the Enter and Tab keys will move to the next or previous field based 
on a normal left to right, top to bottom ordering.

See Also

Modifying Object Attributes and Moving and Resizing Objects

Shortcut
Toolbar:



Open / Fillout / Browse Dialog

Select a file to open by using the File-Open command for master or fillout forms. Master forms 
containing fields can be opened for fillout by using the File-Fillout command. At various other 
points in SuperForms, a Browse button is available to help locate a file of interest. The dialog 
window title will indicate which command was selected.

This dialog is the File Open common dialog used in most Windows programs.

File Name:
This area of the dialog box shows a listing of files available in the current subdirectory. If a tab is
in the scroll bar at the right edge of this area, use it to scroll through the file listing. Use 'List File 
of Type' to quickly choose what file types to show. Enter wildcard file names to control what files 
are shown.

Directories:
This section indicates the current subdirectory. Use the section below to change to a different 
subdirectory. Change subdirectories by using the scroll bar or double-clicking on a directory 
name. If a directory is not shown it may be located as a subdirectory below the one just above 
the current subdirectory. Try double-clicking on a directory name that is one or two levels above 
the current subdirectory.

List Files of Type:
Click on the arrow to change the type of files listed in the section just above.
Available choices are:
Master Forms. (*.frm)
Filled-Out Forms (*.fof)
All Forms (*.frm, *.fof)
All Files (*.*)

During Browse the file types may differ.

Drives:
Click on the arrow to display other available drives.

Network button
If you are connected to a network file server or workgroup, this button will activate your available
network services.
Note:    The single user version of SuperForms does not support network drive or services 
access even though the Network button may be active.



Fillout command (File menu)

Use the Fillout command to open a new window and load an existing Master Form that contains
field objects. This will cause creation of a corresponding Fillout Form file which you will be 
asked to name. The field objects in the Master Form now become data entry fields that can be 
filled out. You can open multiple forms simultaneously. Use the Window menu to choose the 
active form. See Window 1, 2, ... command.

Select the name of the form you want to open in the Fillout dialog box.

You can create new forms with the New command.

When a filled-out form is saved or printed, it is actually committed to use. This means that a 
form printout or a file will be presented to someone for actual use as a form. For example, an 
expense form is committed to use when it is presented to a manager for approval. An invoice 
form is committed to use when it is presented to a customer. To assure accuracy, SuperForms 
will revalidate and recalculate all fields whenever committing a form to use. This processing can 
be overriden via the Process Dialog that appears when saving or printing a form.

Shortcut
Keys: Ctrl + F



Fillout Mode Overview
Click on an area of the dialog box for further explanation.



Font command (Form menu)

Modify font attributes for the selected Text or Field object by using the Font command in the 
Form menu or the object popup menu.

See Also

Font dialog box
Text dialog box



Font command (Options-Defaults menu)

The settings assigned in the Options-Defaults-Font dialog box are used to set defaults for all 
newly created text and field objects. Existing objects are unaffected.

All options are saved into the .INI file with the Options-Save Settings command.



Font Dialog

Choose font name, style etc. for Text and Field objects. When accessed with the Options-
Defaults-Font menu, font selections will only affect newly created objects.

The font characteristics of any Text or Field object can be altered after placement by using the 
Form-Font command, accessible from the main menu or the object popup menu. If an object's 
font height is changed, readjust the object height by repositioning its bottom line.

Font:
Type in the name of the font, or use the section below to select from available fonts.
Shows fonts that are available on your system.

Font Style:
Type in the font style you want, or select from choices below.
The listed styles are valid for the font selected to the left.

Size:
Type in the font size you want even if the size is not an available choice in the section below. 
Some sizes may not be visible or printable on certain systems. Select the font size you want, or 
enter a different size in the section above. TrueType fonts support any size.

Effects:
Additional character attributes for both Text and Field objects.

Color:
Click on the arrow to view a selection of colors for the chosen font.

Sample
Displays the character set as defined in other sections of this dialog box.



Each form window title bar indicates the name of the open form in a highlighted color that is 
different from any other open form window.



An icon within the SuperForms client area (window) indicates an open form that has been 
minimized to clear the work space. The name of the opened form file is displayed below the icon
symbol. Several opened forms may be iconized at once in order to clean up the form display 
area. Double-click on the icon to bring the form back into the foreground and make it the active 
window.



Form Layout command (Form menu)

The Form Form-Layout command will display the Layout dialog box. During form design, the 
form's size, margins, etc. may be modified to accommodate the paper or printer you are using. 
Be aware that some printers do not support all possible margin settings.



Form Layout command (Options-Defaults menu)

The settings assigned in the Options-Defaults-Form Layout dialog box are used to set defaults 
for all newly created forms. Existing forms are unaffected.

All options are saved into the .INI file with the Options-Save Settings command.



Form design (Master Form) and data entry (Fillout Form) work area.



Getting Started
This documentation assumes a working knowledge of Windows and its user interface. Our on-
going goal is to always provide user interface ease, simplicity and consistency within 
SuperForms, as well as consistency with other Windows applications. This will serve to help you
get started as quickly and easily as possible.

To get started, first learn the terminology, then read about what commands to begin with, then 
read about how SuperForms' on-line help is organized.

Terminology

Form
Master Form
Design Mode
Fillout Form
Fillout Mode
Object
Drawing Tool

What to do

In SuperForms, you may be currently working in the Main Window without any active forms. 
Here are at least three ways to get started, listed here in order of complexity.

Note:    Some distribution sets do not contain the files mentioned. Please substitute for 
appropriate file types.

1) Load an existing master form in order to fill it out. Try expense.frm. You may need to change 
to a subdirectory named FIELDS. Use the File Fillout command, type

expense.frm
a dialog box appears asking for the name you want to give the new filled-out form. Type 
expense.fof then select OK. F1 will display fillout help. Now fill out some fields. When ready, 
save it with the File Save command.
2) Load an existing fillout form in order to fill it out or modify it. Try expense.fof. Use the File 
Open command, type

expense.fof
a dialog box appears asking for the name you want to give the new filled out form. Type either 
the same name to modify the existing form or any unique file name to create a different form, 
then select OK. F1 will display fillout help. Now fill out some fields. When ready, save it with the 
File Save command. Or use File Save As to save it with a different file name, leaving the original
file unchanged.
3) Create a new form with File New and design a new master form. Press F1 for design help. 
Select a drawing tool and place an object using the mouse. Place text, fields and graphics in the
same manner. When ready, save it with the File Save command and specify a unique name.

On-line Help

In general, on-line help is available at any time by pressing F1. The help that appears will be 



context sensitive, meaning that it will apply to the current place in SuperForms. Overall, there 
are three ways to access help. They are:

F1 Select a command, then press F1 to get context sensitive help.
Shift + F1 Press Shift + F1, then choose a screen element, toolbar button or menu item on 
which to get help.
Help menu Select a general topic.



Grid command (Form menu)

Use the Grid dialog box to change grid attributes. You can modify grid spacing as often as 
needed using the Form-Grid pulldown menu command. These grid settings only affect and are 
saved with the current form.

Note:    If a different grid setting or multiple grid settings are used during design mode, the last 
grid used will be saved as part of the that particular form regardless of the settings defined in 
the Options-Defaults Grid dialog box.
Example:    Most of the forms you design use the same grid setting. Some of the forms use a 
unique grid setting. Set the Options-Defaults-Grid settings to those most frequently used. For 
those forms that do not use the pre-defined grid options, select Form-Grid to temporarily change
the settings. Saving the form will maintain the grid that was last set during design mode.

You may wish to adjust grid settings for different sections of the form. The snap-to-grid feature 
helps keep objects lined up and assures a professional appearance to your form. There will be 
times when you will want to turn off the snap-to-grid feature in order to hand-place objects that 
do not correspond to any grid. During form design, the F2 key toggles snap-to-grid on and off.

Micro Move Objects
Any time during design mode, the selected object can be “micro-moved” by using cursor keys to
move the object in very small increments. When snap-to-grid is turned on, press Shift and the 
corresponding cursor key to move the selected object from grid point to grid point.



Grid command (Options-Defaults menu)

Use the Grid dialog box to set grid attributes. Save the settings as default for newly created 
forms by using the Options-Save Settings command. You can modify grid spacing for current 
forms as often as needed using the Form-Grid pulldown menu command. All options are saved 
into the .INI file with the Options-Save Settings command.

You may wish to adjust grid settings for different sections of the form. The snap-to-grid feature 
helps keep objects lined up and assures a professional appearance to your form. There will be 
times when you will want to turn off the snap-to-grid feature in order to hand-place objects that 
do not correspond to any grid. During form design, the F2 key toggles snap-to-grid on and off.

Micro Move Objects
Any time during design mode, the selected object can be “micro-moved” by using cursor keys to
move the object in very small increments. When snap-to-grid is turned on, press Shift and the 
corresponding cursor key to move the selected object from grid point to grid point.



Grid Dialog

Use the form design grid settings to help you place objects precisely, and to help align objects 
vertically and horizontally. The grid will not be visible in fillout mode. When accessed with the 
Options-Defaults-Grid menu, grid selections will only affect newly created forms.

The grid characteristics of an object can be altered for an existing form by using the Form Grid 
command, accessible from the main menu or the object popup menu. The dialog box title will 
not include "Defaults" when modifying an existing form.

Spacing
Horizontal:
Horizontal spacing determines the spacing between vertical lines of the grid.

Vertical:
Vertical spacing determines the spacing between horizontal lines of the grid.

Selections
Grid Visible:
For design mode, toggle the on-screen visible grid ON / OFF. In Fillout Mode the grid is always 
off.

Snap to Grid:
When placing, moving or resizing objects, end points are automatically forced to conform to the 
nearest grid coordinates. For example, each end of a Line object will "snap-to" the nearest grid 
point. All four corners of Text, Field and shaped objects will "snap-to" each of the nearest grid 
points, giving you simpler, easier placement capability. A grid point is any intersection of a 
horizontal and vertical grid line. You may also “micro-move” (arrow keys) and “mini-move” (Shift 
plus arrow keys) objects for even finer control. The F2 key will toggle this snap-to option while 
designing a form.

Grid Color button
Access the Color dialog to choose from a given color set.



A handle is a small black square on the end point, corner point or edge of a selected object. A 
handle represents possible resizing points. When the mouse cursor is on any handle, the cursor
changes shape to represent the possible resizing that could take place via mouse click and drag
movement.



Context Help command

Use the Context-Help command to obtain help on a specific SuperForms function. When you 
choose the Toolbar's Context Help button, the mouse pointer will change to an arrow and 
question mark. Click somewhere in the SuperForms window, such as another Toolbar button, or 
pulldown menu. The Help topic will be shown for the item you click on, if it applies.

Shortcut
Toolbar:
Keys: Shift + F1



Horizontal Scroll bars

Horizontal Scroll bars are positioned at the bottom. Scroll bars are displayed at the right and 
bottom edges of the form window when the form exceeds the size of that window. The scroll 
boxes inside the scroll bars indicate your vertical and horizontal view of the form. You can use 
the mouse to bring other parts of the form into view.



How To . . .
Organize Files

Work With Multiple Forms

Micro-move and Mini-move Objects

Utilize a Sound Card

Use Form Design and Fillout

Modify Object Attributes

Use Command Line Options

Create White Letters Over Solid Colors

Select Multiple Objects

Use The Grid

Move/Resize Objects

Creating icons for your forms.



How To Create White Letters Over Solid Colors
This output effect only works with laser printers.

Create a graphic block the size you want using the Rectangle, RoundRect, or Ellipse tools.

Under the Form pull down menu, select Brush and in the dialog box change the Style to Solid. 
While still in the dialog box change the color to Black and click OK a couple of times to get back 
to the form.

Create a text block of the same size under the graphic you just made. Enter the text you need to
place over the blackened graphic.

Press the Ctrl + C key followed by the Ctrl + V key to make a duplicate text block. Hold down 
the Shift key and arrow down until the new text block is below the original one.

Under the Form pull down menu, select Text and click over the Text Color button to change the 
color of the second text block to white and click OK a couple of times to get back to the form.

You should now have a black patch with a readable text block below it and a highlighted 
unreadable text block below that one.

Hold down the Shift key and arrow up until the unreadable text block is positioned over the black
graphic object. Move the mouse pointer over the readable text block (the one you made first) 
and click to highlight it.

Under the Form pull down menu, select Printable so that the object will not be sent to the printer
as part of the form.

Hold down the Shift key and arrow up until the readable text block is positioned over the black 
graphic and the unreadable text block.

The printed page will show a black graphic with white text inserted, while the display screen will 
show a black graphic with highlighted black text within the colored area.



How To Micro-move and Mini-move Objects
Often times you will need an object positioned between grids points. You can use SuperForms' 
micro-move feature to fine-tune the form. Micro-move works whether or not “snap-to-grid” is 
turned on via the Options-Defaults-Grid or Form-Grid dialog box snap-to-grid selection.

To use this feature, select an object and use the arrow keys to micro-move it to a new position. 
Shift-arrow key (mini-move) will move the object from grid point to grid point if “snap-to-grid” is 
turned on. If “snap-to-grid” is turned off, the movement is actually the same as micro-move.

Do NOT continue to hold the mouse button after you have selected the object as this will cause 
the object to snap back to the defined grid if you have “snap-to-grid” turned on.

After dragging an object halfway across the form to a new location, sometimes the mouse is a 
bit difficult to use for precise placement with “snap-to-grid” toggled OFF. In this case you can 
drop the object very close to the position desired and use micro-move to fine tune the 
placement.

Note:    Even if snap-to-grid is turned on, you may still micro-move a selected object with the 
keyboard arrow keys as long as the object is still selected. This allows for very precise 
positioning of the object.

You may also use mini-move by depressing and holding the Shift key while making 
movements with the cursor keys. If “snap-to-grid” is turned on, the movements here are actually 
from grid point to grid point. If “snap-to-grid” is turned off, then the movement is actually the 
same as micro-move.



How To Modify Object Attributes
An object can have one or more of the following attribute groups:

Text
Font
Pen
Brush

Each of these attribute groups except for Printable, has an associated dialog box that allows 
modification of the attributes within that group. Printable is a simple on/off toggle.

An object is created by first selecting a drawing tool, then using the mouse to place and size it. 
At creation time, an object's attributes are defined by settings in the Options-Defaults menu. 
These defaults are saved in the SPF.INI file in your Windows directory. For example, the 
Options-Defaults-Text command accesses the Text dialog box for the text default attributes. 
Field Setup is unique in this regard because it's default setting are fixed. This is due to the 
complex nature of a field object's attributes which involve formatting, calculations, etc.

Once an object exists, its attributes can be modified at any time in design mode by altering 
settings that are accessible via the Form menu or the object popup menu. These settings are 
saved with the object in the Master Form (.FRM) file. For example, when a rectangle object is 
selected, the Form-Pen command accesses the Pen dialog box for the Pen attributes of the 
selected rectangle.

See Also

Moving and Resizing Objects



How To Move/Resize Objects
Once an object is placed in design mode, it can later be moved, resized, deleted or copied. 
Delete and copy are available through the Edit Cut/Copy/Paste menu commands. Moving and 
resizing are accomplished through mouse click and drag operations. Arrow keys can also be 
used to move an object.

Selecting Objects
Similar to other operations on an object, select it before moving or resizing. Choose the Select 
drawing tool via the toolbar button, or the Edit Select or Draw Select menu commands. 
Selection is done by a single left button mouse click anywhere on or inside the object. A 
selected object is indicated by the appearance of handles on all its end points, corner points or 
edges.

Moving
After selection, move an object by a drag and drop mouse operation. To drag, hold the left 
mouse down anywhere on a selected object and move it while continuing to hold the left mouse 
button down. To drop, simply release the mouse button.

The up, down, left and right arrow keys will also move an object. The object is moved in the 
smallest possible increment in the direction of the arrow key. When the grid is on and the Shift 
key is also pressed, the object moves to the next grid point following the direction of the arrow.

Resizing
After selection, resize an object by first moving the mouse cursor over one of the selection 
handles. You will notice the mouse cursor changes to either a left-right arrow, up-down arrow, or
a diagonal arrow. While the cursor is one of these shapes, object resizing is done by a drag and 
drop mouse operation. Note that resizing is disabled when multiple objects are selected.

A left-right or up-down arrow usually appears at the edge of an object. This represents the 
possibility of resizing by moving only the edge represented by the handle the cursor is on.

A diagonal arrow usually appears at an end point or corner point of an object. This represents 
the possibility of resizing by moving this point. For corner points, both edges are resized to 
match the mouse movement.



How To Organize Files
For your own convenience, you may want to keep certain files separated into different 
subdirectories.

Examples might be:

Use a Pre-Printed Forms subdirectory named      C:\SPF\PPF\      for storing all forms that have 
data entry fields, but print only the data and not the background form design. This type of 
master form is used for pre-printed forms purchased from an office supply store, or from a forms
catalog. This type of functionality is also known as CFO (clear forms overlay.)

It is sometimes convenient to place all master forms in one directory, and all fillout forms in 
another.

Other subdirectories may be assigned for departments, specific employees, job/task related 
forms, etc.



How To Select Multiple Objects
Single Objects:

Cut, Copy, Paste a Single Object:
Open an existing form and click the mouse cursor on one of the objects in the form to select it. 
Press the Ctrl + C key combination to copy the object to the clipboard. From the File pulldown 
menu select New, then click the OK button. Press the key combination Ctrl + V to paste the 
object from the clipboard to the new form. Now you have two forms with a duplicate copy of the 
object. Using the key combination Ctrl + X while in the original form would have deleted the 
object from the form and placed it into the clipboard, making it available for a Paste operation in 
another form.

Use the pulldown menu command Edit-Cut ( Ctrl + X ) to move an object from the form to the 
clipboard.
Use the pulldown menu command Edit-Copy ( Ctrl + C ) to move a duplicate of the object to the 
clipboard.
After using the Cut or Copy features, create or move to a different form.
Use the pulldown menu command Edit-Paste ( Ctrl + V ) to place one or more duplicates of 
what is stored in the clipboard.

Multiple Objects:
Normally, mouse clicking on an object will select it and deselect the previously selected object if 
there was one. Holding down the Shift key during object selection will prevent deselection of 
other objects. This allows the selection of more than one object at a time. This group of objects 
can be moved, cut, copied, or pasted, very much like what can be done with singly selected 
objects.
 



How To Use Command Line Options
SuperForms has two command line options that can direct SuperForms to automatically load a 
form file at startup. These options are not case sensitive. Only one command can be used at a 
time.

Using a command line option makes it possible to create any number of Program Manager 
icons, each loading a different form.

/M filename
Open the Master form indicated by filename. This form is automatically loaded into design 
mode after SuperForms startup.

/F filename
Open the Master or Fillout form indicated by filename. This form is automatically loaded into 
fillout mode after SuperForms startup. Before fillout can begin, a new name must be chosen for 
the form. This allows for either a Master or Fillout form to act as a fillout template. The File 
Fillout command works similarly.



How To Use Form Design and Fillout
Form Design

The goal here is to create a Master Form by using SuperForms' drawing tools to place objects 
at appropriate places on the form. Once an object is placed, it can be moved, resized or have its
characteristics modified.

Object characteristics can be selected in two ways. One way is by setting default characteristics
via the Options-Defaults menu. These defaults specify the characteristics of newly created 
objects. The other method of setting object characteristics is by selecting an existing object, 
then modifying its characteristics with the Form menu.

When a master form is complete, save it. Once saved it can be reused repeatedly as a template
for form fillout.

Form Fillout
The goal here is to place data into each field in order to fill out the entire form. When done filling 
out a form, save it to a unique name. When ready to fill out a new form, you can use the Edit 
Clear All or File Fillout commands to do so.



How To Use The Grid
You are not limited to one grid setting during the design of a form. Adjustment of horizontal and 
vertical grid settings can be made at any time to within two decimal places, for example, 0.25, 
0.37, 0.50, etc. If the grid setting is changed, all previously set objects will not “snap-to” the new 
grid unless selected and moved with the new grid settings in place and “snap-to-grid” turned on.
The "snap-to-grid" feature is defaulted to ON at program installation.

“Snap-To-Grid” means that while you are moving or sizing an object (e.g..      creating a line) the 
end points will “snap-to” the nearest grid point intersections around the object. If the entire 
object is selected, it will “snap-to” the nearest grid coordinates. Or if just one of the “handles” on 
a corner or side is selected, only it will snap-to-grid when released. The “snap-to-grid” feature 
can be turned on or off at will via the Form-Grid dialog box. The F2 key also toggles the “snap-
to-grid” feature.

Note:    Even if snap-to-grid is turned on, you may still micro-move a selected object with the 
keyboard arrow keys as long as the object is still selected. This allows for very precise 
positioning of the object.

You may also use mini-move by depressing and holding the Shift key while making 
movements with the cursor keys. If “snap-to-grid” is turned on, the movements here are actually 
from grid point to grid point. If “snap-to-grid” is turned off, then the movement is the same as 
micro-move.

Varying text sizes, lines, boxes, other shapes and imported graphics may need different grid 
settings to place them precisely where you want them.



How To Utilize a Sound Card
An icon representing a prerecorded sound file can be placed on a form. Sound files stored in the
.WAV format can be played during data entry for instructions, or to further “illustrate” a topic. 
(e.g..      telephone ringing, or other sounds)    Use the Edit-Insert New Object command to place 
an icon on your form that will play back the sound file. Choose "Create from File", enter the 
sound file name, then OK.

Check the recording section of your sound card manual for instructions on how to create your 
own sound files and use them in forms you design. The user of your form will be able to click on 
an icon to listen to the file associated with the icon. Embedding the sound file with an automatic 
link will keep the sound file separate from the form.

Sound files will only be played if your system has the proper Windows sound drivers and 
hardware installed. Consult your sound card supplier for more details.

See Also

Inserting OLE Objects



How To Work With Multiple Forms
It may be helpful at times to have several forms open at once for comparison, work in progress, 
or to copy / move text, fields, or objects from one form to another. Too many open forms may 
clutter up your screen desktop. Iconizing (minimizing to icon view) some of the forms using the 
Minimize command contained in the Control tab menu for the form window can clean things up 
considerably.

One example of the convenience of multiple open forms is in the case of cloning (or duplicating)
an existing form (master or fill-out) and modifying it for a slightly different use while preserving 
the original form. To do this, use “File-Save As” to save the form to a new and different name. 
The original form is saved and closed for safety. You may reopen the original with the File-Open 
command or Toolbar icon in order to keep it on-screen for reference. You can even open 
another form that has an image (like a logo or signature) that you would like to copy to your new
form. Highlight the image in the third open form and select the Edit-Copy command. The image 
is stored in the Windows' clipboard and can be pasted into the new form. Click on the new form 
that is to contain the image and select the Edit-Paste command. The object will immediately 
appear in the new form with all attributes identical to the original.

Available system memory and system resources have a lot to do with being able to transfer 
images. If problems occur, select the image and position the mouse cursor on the bottom right 
corner object handle (tab). Press and hold the left mouse button and drag the corner to make 
the image smaller. Repeat the transfer steps then increase the images size after moving it to the
other form. If this is not sufficient to move the image, you may need to shut down some of the 
other applications you currently have running in Windows.



An Inactive form does not have a highlighted title bar. Click on any visible part of the form to 
make it the active form. Select the Window pulldown menu for a list of open form file windows.



Contents command (Help menu)

Use this command to display the opening Help screen. From here you can select any of the 
main help topic categories, including both instructional and reference information. Help is 
displayed by another program called WINHELP, which is provided with Windows.

At any time while in help, you can click the [Contents] button to return to the Contents screen.

Add your own notes to the help file by using Help's Edit-Annotate command or the Annotate 
toolbar button. All annotations are saved in the Windows program subdirectory as filename 
[program].ANN. These annotations can only be modified and viewed during display of this help 
file. As a reminder, annotated topics will display a paper-clip icon to the left of the topic title.



Installation
The installation process is accomplished by running the INSTALL.EXE program present on disk 
1 of the distribution disks. INSTALL copies the program and its support files, this help file and 
various other information files. When system files already exist on your system that are newer 
than identically-named files on the SuperForms distribution disks, INSTALL will not overwrite the
newer files. Installation and use of SuperForms must always follow the SuperForms License 
Agreement.

Command Line Options can be used to set up SuperForms as a form fillout program, allowing 
any number of Program Manager icons to be created for filling out forms that act as templates.

Here is a list of functional files that comprise the SuperForms product. This list may prove useful
when troubleshooting any difficulties that may occur either during installation or when running 
the SuperForms program.

SuperForms Progam Files

These files belong in the SuperForms program directory since they are unique to SuperForms. 
Note: File name SPF.* may vary for TestDrive installations.

SPF.exe
ezx1.dll
SPF.hlp

System Support Files

These files are in general use in the industry, and should reside in the Windows System 
directory, typically c:\windows\system.

ctl3d.dll
mfcoleui.dll

OLE Version 2 System Files

These files implement the Microsoft Windows OLE Version 2 system. As above, they are in 
general use and should reside in the Windows System directory. The regedit.exe program, 
which is part of Windows, must be present on your system during installation, to allow proper 
configuration of OLE 2.

compobj.dll
ole2.dll
ole2conv.dll
ole2disp.dll
ole2nls.dll
ole2prox.dll
storage.dll
typelib.dll
ole2.reg
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SuperForms™ is the Eforms Processor for Windows!

Create, Modify, Fill-in, Save any form in minutes!

** SuperForms™ Release 96f (v2.11)

** SuperForms<tm> Release 96fa for Windows is the
      SuperForms Automation Processor!

** Create, Fill-Out (internal), Fill-In (pre-printed), Modify,
      Navigate, Save, Revise, ANY FORM in minutes!
    
** WYSIWYG, multiple open forms, cut/paste, protected
      fields/objects, much, much, more.

* Whether your business is small or large, you can easily
    and quickly Create and Fill any document,
    Fill-in (internally generated forms), Fill-out
    (pre-printed forms), Save, Save-as, Revise, and/or
    Print (even to FAX) all kinds of forms in minutes.

* Create custom forms (lines, boxes, etc.) on screen and
    add fill-out fields, and you're done!

* You can even fill-out pre-printed forms! Simply design an
    "overlay" form.

* SuperForms<tm> for Windows is here!!!

* SuperForms is GREAT FOR:
 * Perfect form fill-out.
 * Commercial Printers ... speeds form design, modification.
 * In house publication departments ... Improve response time,
      ease update process, cut costs.
 * Low cost forms development ... Develop and print all of your
      forms without outside help.



 * Printing any quantity of custom forms on your laser printer
      ... on demand!
 * Great for basic desktop publishing too!

* SuperForms's focus is on forms design, production and fill-out.
    Unlike page document composition, the logical object oriented
    drawing tools are specifically tailored and optimized for forms
    design and manipulation. Its WYSIWYG (what-you-see-is-what
    -you-get) interactive screen is clear, intuitive and easy to use.
    Font size,    typeface and printer options (including FAX transmission)
    are limited only by what is available under Microsoft Windows for your
    system.    For truly flexible forms production, you can even print the
    filled-in data and the form at the same time or, fill-out to
    pre-printed forms.

* You can easily customize any of the 70+ included form templates 
      to create any new form you desire.

*    DESIGN FORMS QUICKLY and EASILY:
      * Using the display screen and mouse, you can perform fully
          interactive forms composition by creating and manipulating
          various "objects". 
      * WYSIWYG means that the screen looks like the final printed
          from, showing typefaces, font sizes, lines, rectangles, 
          rounded rectangles, ellipses, circles, shading, logos, etc.
          Size any object for creative impact.
      * Text can be automatically word-wrapped, justified (left, 
          center, right, full), fonted, colored, etc. in any text
          or fill-out field. 

Other Form Design and Fill-out Features include:
* Extensive on-line help and MANUAL with BROWSE, TEXT SEARCH, PRINT.
    SPF's powerful Browse and global Text search features (not available
    in "regular" Windows help files) will allow you to find any topic,
    word, or phrase quickly. You will also be able to print any topic
    or group of topics on demand. The unique "tree" structure gets you
    to your information fast. NEVER be without your manual again!
* On-screen grid (user adjustable; does not print) and
    snap-to-grid allow very quick and precise positioning of
    all objects and fields.
* Fill-out master or modify completed forms. No need to
    retype redundant information. 
* Open multiple forms at once for quick reference or cut-and-paste.
* Multiple form views can be full window, window cascade,
    tile view, or reduced to icons.
* Fourx different working view magnifications 25% to 300%
    are available for even the most intricate work.
* Precise continuous coordinate display for accurate positioning.
* Tool bar and status line control allow you to customize
    appearance and operation of the program.
* Copy, cut, and paste objects between multiple SuperForms Eforms.



* Define page sizes, margins, layouts, orientation.
* Draw lines, boxes, shapes, fill patterns of many types,
    change orientation and color.
* 26 drawing tools are provided form design. There are five
    pen line styles, 10 thicknesses and eight brush patterns.
* Other drawing tools include rectangle, round rectangle, and
    ellipse which can be melded with any of the brush patterns. 
* Fill-out fields can be placed anywhere on the form, and in fill-out 
    mode, the master part (or background) of the form cannot be modified 
    so as to assure perfectly filled out forms every time.
* Print to any Windows supported device, even directly to your
    FAX/modem (third party drivers required) for immediate transmission
    of your form.
* Use any Windows font including Bar Codes, and special characters like 
    Wingdings.
* Quickly bold, underline, italicize, strike-through, etc. any text field.
* You can even paste text from your trusty ol' DOS programs via
    Window's clipboard.

* New features in release 96f include:
* Full text justification option.
* Numerous touchups.
* Multiple object selection for move, copy, paste, etc.
* Support for international measurements and paper sizes. 
    Window's international settings are monitored and the appropriate defaults 
    are used. (ISO paper sizes and metric mesurements, for instance)
* Unlimited character size for text objects. (Old limit was 256 characters.)
* Multiple copy printing.
* Screen updates are faster too.
* SuperForms can save thousands of dollars in
    pre-printed forms and time, but ...

* Call for Multi-user, LAN, Server, Site, Regional and Corporate licensing.

Mail Orders:
EZX Corporation / SuperSoftWare
"The SuperForms Automation Company"
403 E. NASA Rd., Suite 377
PO BOX 58177    SPF96f
Webster(Houston), Texas 77598-8177 USA

Voice Credit Card ORDERS may call
1-800-713-2468 ext.SPF96f (toll free in USA)

FAX Credit Card ORDERS: 1-800-713-3579 ext.SPF96f
(toll free USA; All other correspondence ignored.)

WE ACCEPT Visa, MasterCard, Discover/Novus, American Express.

For orders, information, technical and all other business, call:
Voice:1-713!-280-9900      FAX:1-713!-280-0099 (24hrs)    BBS:1-713!-280-8180 (24hrs)



Email to: ezx@cris.com      or      EZXHOU@aol.com
                    America Online: EZXHOU          Compuserve: 76350,3111
World Wide Web: http://www.cris.com/~ezx      or,    http://home.aol.com/EZXHOU

Specifications, pricing, etc. are subject to change without notice.

Copyright 1996-0501 all rights reserved by:

Also ask about custom design and “sub-publishing” services.

Special versions of FormPower/FillPower specifically tied to custom developed forms, are the 
“engines” that drive products like ExportPower™, PackageTrakker™, YourForms PRO™, 
WinDD250™, WinSF171™, AnyPower™, MedPower™, ExpensePower™, etc. Call for details.

Should you require a special “sub-published” edition of FormPower/FillPower customized for 
you and your special form or application, contact EZX at the address and numbers below. 
Developers and VARs only, please.

Specifications, pricing, etc. are subject to change without notice.

Copyright © 1996, All rights reserved by:

EZX Corporation / SuperSoftWare
“The SuperForms Automation Company”
403 E. NASA Rd., Suite 377
PO Box 58177    -    SPF96f
Webster (Houston), TX    77598-8177    USA

Credit Card Orders (Visa, MasterCard, Discover, American Express) may call the 
ORDER DESK @ 1.800.713.2468 ext.SPF96f (toll free in the USA)
(There is a per-minute charge for service/support calls to the above number.)

Technical Support:
Voice: +1-713-280-0080 (9:00am - 4:00pm    Central    USA    M - F)
EZ-Host! BBS: +1-713-280-8180 (E-mail; Support, etc. 24hrs. per day)
Internet: ezx@cris.com    or    EZXHOU@aol.com
AmericaOnLine: EZXHOU (E-mail)
CompuServe: 76350,3111 (E-mail)
World Wide Web: http://www.cris.com/~ezx

or    http://home.aol.com/EZXHOU

For all other business and International:
Voice: +1-713-280-9900 (Questions, Comments, observations, & 

support.)
FAX: +1-713-280-0099 (Inbound FAXes; 24hrs per day.)

Shipping & Insurance:



$7    USA-48 for ground (7-10 days) shipping. $2 for each additional item.
$12 USA-48 for 2nd business day shipping. $2 for each additional item.
$24 USA-48 for Next Business day shipping. $4 for each additional item.
$12 AK-HI-PR-VI-GU-AS; Canada (all provinces). $3 for each additional item.
$19 Elsewhere. $4 for each additional item.
• You can request whatever shipping you wish, such as your own FedEx number, for 
actual cost plus $7 handling charge per order.
Pricing, etc. are subject to change without notice. Contact EZX if this information is over
6 months old.



Keyboard Commands
Text and Field Edit Objects

Arrow keys Cursor movement
Home Beginning of line
End End of line
Ctrl + Home Beginning of text
Ctrl + End End of text
Ctrl + Left Previous word
Ctrl + Right Next word
Shift Add to any above key to select text
Insert Toggle insert / overstrike mode
Delete Delete a character to the right
Enter Terminate text entry
Ctrl + Enter Force new line
Alt + Backspace
or Ctrl + Z

Undo

Fillout Mode
Arrow keys Cursor movement
Tab Next field (Options-Preferences-Tab between 

fields toggled ON)
Shift + Tab Previous field (Options-Preferences-Tab between

fields toggled ON)
Enter Next field
Shift + Enter Previous field

Form / Window Movement
PageUp Scroll up page
PageDown Scroll down page
Ctrl + PageUp Scroll left page
Ctrl + PageDown Scroll right page
Ctrl + Home To First field
Ctrl + End To Last field
Ctrl + Up Scroll up line
Ctrl + Down Scroll down line

Design Mode
Arrow keys Micro-Move selected object
Shift + Arrow keys Move selected object
F2 Turn ON / OFF snap-to grid

(see Options-Defaults-Grid)

Menu Hot Keys
Ctrl + Key combinations:

Ctrl + N File - New
Ctrl + O File - Open
Ctrl + F File - Fillout
Ctrl + S File - Save



Ctrl + P File - Print
Ctrl + X Edit - Cut
Ctrl + C Edit - Copy
Ctrl + V Edit - Paste
Ctrl + E Edit - Text
Ctrl + Z Edit - Undo Delete
Ctrl + T Edit - Text Feed - Time
Ctrl + D Edit - Text Feed - Date
Ctrl + R Refresh Screen to eliminate screen movement 

artifacts.
Ctrl + F4 Form Control - Close
Ctrl + F6 Form Control - Next

Alt + Key combinations:

Alt + F4 Program Control - Close
Alt + Backspace Edit - Undo Delete



For internal use only.



Form Layout Dialog

When creating a form with the File-New command, these settings will only apply to the new 
form.

The layout of a form can be altered after creation by using the Form Form Layout command, 
accessible from the main menu. The dialog box title will not include "Defaults" when modifying 
an existing form.

Choose form size, orientation and margin settings. When accessed via Options Defaults Form 
Layout, the layout will only affect newly created forms. All of these settings can be changed after
form creation.

Form Size:
Choose a pre-defined or user-defined form size. Set form orientation (Portrait or Landscape) to 
match intended page printing. User-defined sizes are entered in the "Size" area below. Pre-
defined choices are:

Letter 8.5 x 11 in
Legal 8.5 x 14 in
11 x 17 in
A3 29.7 x 42.0 cm
A4 21.0 x 29.7 cm
A5 14.8 x 21.0 cm
B4 25.0 x 35.4 cm
B5 18.2 x 25.7 cm
Fanfold 8.5 x 12 in
Fanfold 8.5 x 13 in

Units:
For measurement units, SuperForms accepts numbers up to two decimal places. When 
modifying a form, units can be changed for informational purposes only. Units always revert 
back to the setting made in the Options Defaults Form Layout dialog.

Units will default to the Windows International settings.

Margins:
Represents blank areas at all four edges of the form. Margins can be viewed through Print 
Preview.

Margin settings for the page are not shown as part of the display during form design. However, 
the Status Bar coordinate display does include these margins.

Size:
For pre-defined sizes, the settings are not changeable and reflect the currently chosen form 
size. When a user-defined form size is chosen, these sizes can be set. When printing, make 
sure the printer settings match the intended printing orientation, either portrait or landscape. 
Accepted values are 2.00 through 30.00.



FormPower License Agreement
NOTE: The following agreement is meant for a single-user / single-machine use of
SuperForms.
• If you have multi-machine, network, site or Corporate licensing needs, contact 
EZX's sales department at the numbers below.

The SuperForms program and all of its components are protected by United States Copyright 
Law and International Treaty provisions. All worldwide rights are reserved.

Copyright ©1996 All Rights Reserved
Distributed by:      EZX Corporation

“The SuperForms Automation Company”
P. O. Box 58177, Webster, TX 77598-8177 USA

Phones: Voice:1.713.280•9900      FAX:1.713.280•0099
BBS:1.713.280•8180      Tech:1.713.280•0080

LICENSE/REGISTRATION STATEMENT (This does not apply to TestDrive versions which are 
licensed for 15 day trial use.): The SuperForms (PROGRAM) is protected by United States 
Copyright Law and International Treaty provisions. All rights are reserved. You may use this 
program as indicated in the serial number, license/registration agreement, and purchase receipt,
on a single machine. (Your hard copy license/registration card may indicate authorization for 
multiple-machines or a network for the stated amount of users. If this is the case, that card 
supercedes this license statement with regard to a single user.). EZX Corp. hereby grants a 
“book” license to the original individual user (even if purchased by a company or other 
organization) of this copy of SuperForms. You may use the program on your computer and 
make one backup copy, as long as there is no possibility of use or residence on more than one 
machine at any time. Just like two people cannot read the same book in different locations at 
the same time. Use of any kind by a single user version on a Local Area network is prohibited. 
Every copy of SuperForms has a unique serial number embedded within it, for traceability. You 
may not make, sell, or give copies of this program and documentation to anyone. No 
exceptions. EZX Corp. makes no warranty of any kind, expressed or implied, including (without 
limitation), any warranties of merchantability and/or fitness for a particular purpose. EZX Corp. 
shall not be liable for any damages, whether direct, indirect, special or consequential arising 
from a failure of this program to operate in the manner desired by the user. EZX Corp. shall not 
be liable for any damage to data or property which may be caused directly or indirectly by use of
the program. EZX Corp. makes no claims, offers no warranties, and assumes no responsibility 
for any sort of damage (mental or physical) resulting from the apparent or actual use of our 
products. Any text files, printer control files, or forms provided with this product are not 
guaranteed as to merchantability or fitness for its ultimate use. User accepts all responsibility for
use and may not resell any supplied text file, printer control file or form. A person, business, 
corporation, government organization or any other entity, to do so is strictly forbidden from using
unregistered copies of this program and, is a violation of this license agreement. SuperForms 
may not be distributed in conjunction with any other product, without written permission from 
EZX Corp. The License Agreement and statement shall be construed, interpreted and governed 
by the laws of the United States of America and the state of Texas.

All pricing, terms and conditions are subject to change without notice. Some of the terms used 
within this document are trademarks of the following firms: International Business Machines, 



Sony, Microsoft, Lotus Development Corp., Intel Corporation. Etch-a-Sketch is a registered 
trademark of Ohio Art.

FormPower PRO, FillPower PRO, HotFormz PRO FormEZ, EZ-Forms Gold, EZ-Forms, EZ-
Forms Lite, SuperForms, SuperForms PRO, PF, EZ-Forms PLUS, EZ-Forms eXecutive, EZ-
Forms DataBase, EZ-InFORMa dB, EZX-Word, EZ-Spreadsheet, EZ-DiskCopy PRO, etc. are 
trademarks of EZX Corporation. Revised 04/96.    ©1996 EZX.



Line command (Draw menu)

Line Drawing tool. Activate by clicking on the Line Toolbar button, or by selecting the Draw-Line 
command.

1) Position the mouse pointer to where you want to begin drawing.
2) Press and hold the left mouse button while dragging the mouse, thereby drawing a line to the 
desired length.
3) Release the mouse button when done.

When the Snap-to-Grid option is selected in the Grid dialog box, the line's end points will "snap" 
to the nearest grid points.

See Also

Modifying Object Attributes and Moving and Resizing Objects

Shortcut
Toolbar:



SuperForms Logo and Icon is Copyright © 1996 and Trademark ™ by EZX 
Corporation.

Thank you for using SuperForms™ for Windows © 1996 by and from:    (All rights 
reserved.)

EZX Corporation / SuperSoftWare
“The SuperForms Automation Company”
403 E. NASA Rd., Suite 377
PO Box 58177    -    SPF96f
Webster (Houston), TX    77598-8177    USA

Credit Card Orders (Visa, MasterCard, Discover, American Express) may call the 
ORDER DESK @ 1.800.713.2468 ext.SPF96f (toll free in the USA)
(There is a per-minute charge for service/support calls to the above number.)

Technical Support:
Voice: +1-713-280-0080 (9:00am - 4:00pm    Central    USA    M - F)
EZ-Host! BBS: +1-713-280-8180 (E-mail; Support, etc. 24hrs. per day)
Internet: ezx@cris.com    or    EZXHOU@aol.com
AmericaOnLine: EZXHOU (E-mail)
CompuServe: 76350,3111 (E-mail)
World Wide Web: http://www.cris.com/~ezx

or    http://home.aol.com/EZXHOU

For all other business and International:
Voice: +1-713-280-9900 (Questions, Comments, observations, & 

support.)
FAX: +1-713-280-0099 (Inbound FAXes; 24hrs per day.)

Special versions of FormPower/FillPower specifically tied to custom developed forms, 
are the “engines” that drive products like ExportPower™, PackageTrakker™, 
YourForms PRO™, WinDD250™, WinSF171™, AnyPower™, MedPower™, 
ExpensePower™, etc. Call for details.

Should you require a special “sub-published” edition of FormPower/FillPower customized for 
you and your special form or application, contact EZX at the address and numbers above. 
Developers and VARs only, please.



Maximize button

The Maximize button for a form window will expand the window to full SuperForms client 
window size and set the currently active window display to be the default until changed.

Shortcut
Mouse:

Click on the maximize icon  on the title bar, or 
double-click the title bar.



Maximize button

Use this button to enlarge the active window to fill available space. A form window Maximize 
button will expand its window to the size of the SuperForms main window, and set it to be the 
active window. The main window Maximize button will expand the SuperForms main window to 
fill the entire screen.

Shortcut
Mouse:

Click the maximize icon  on the title bar, or double-click the title bar.
Keys: Ctrl + F10 enlarges active form window.



Minimize button

The Minimize button of a form window will iconize the active window and display the icon within 
the SuperForms client area, usually at the bottom.

Shortcut
Mouse:

Click the minimize icon  on the title bar.



Minimize button

In the main window, use this command to reduce the SuperForms window to an icon. The 
Minimize button of a form window will iconize the active form window and display the icon within
the main window (client area).

Shortcut

Mouse: Click the minimize icon  on the title bar.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog 
box with the arrow keys.

Note:    This command is unavailable if you maximize the window.



New command (File menu)

Use this command to create a new master form. The Form Layout dialog box will appear to 
allow selection of form dimensions and margins.

You can open an existing master or fillout form with the Open command.

Shortcut
Toolbar:

 Keys: Ctrl + N



Next Window command (Form Control menu)

Use this command to switch to the next open form window. SuperForms determines which 
window is next according to the order in which you opened (or last edited) the windows.

Shortcut
Keys: Ctrl + F6



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.



Modify the selected object to a different file type using an external program.



Open command (File menu)

Use the Open command to open an existing form in a new window. You can open multiple forms
at once. Use the Window menu to switch among the multiple open forms. See Window 1, 2, ... 
command.

Choose Fillout to open a form containing fields for data entry.

Select the name of the form you want to open in the Open dialog box.

You can create new forms with the New command.

Note: The single user, non-network version of SuperForms will not read-from or save-to a 
network drive.

Shortcut
Toolbar:

Keys: Ctrl + O



Overview
SuperForms is a forms processor, making the creation and fill-out of forms simpler and easier 
than it would be if you were using any other kind of program. SuperForms takes the best 
features from word processing, desktop publishing and spreadsheets, and combines them to 
create a forms processor that avoids the complexity of any other solution.

SuperForms is organized into two modes of operation, Design and Fillout. Your interaction will 
be in one of these modes at any given time. This Overview is meant to help you understand the 
SuperForms user interface, including menus, toolbars, icons, etc.

Design Mode Overview
Master forms are created in Design Mode. A master form can be printed for fillout by hand, or it 
can be filled out within SuperForms in the Fillout Mode. The master form file extension is .frm. 
When creating a master form for fillout with SuperForms, numerous features including 
Calculations, Validations, Pick Lists, Field Help, etc. can be used to make fillout quicker, easier 
and more accurate.

Fillout Mode Overview
A master form is filled out in SuperForms, which creates a filled-out form. The filled-out form file 
extension is .fof. None of the Design Mode functionality is available during fillout, thereby 
avoiding problems with inadvertent modification of headings, borders, etc.



Overview command (Help menu)

Use this command to display the Overview Help screen. The Overview is meant to help you 
understand the SuperForms use interface, including menus, toolbars, icons, etc.

At anytime during Help, you can click the [ Contents ] button to return to the opening screen.

Add your own notes to the help file by using Help's Edit Annotate command or the Annotate 
toolbar button. All annotations are saved in the Windows program subdirectory as filename 
[program].ANN. These annotations can only be modified and viewed during display of this help 
file. As a reminder, annotated topics will display a paper-clip icon to the left of the topic title.



Paste command (Edit menu)

Use this command to insert a copy of the clipboard contents into the form. This command is 
unavailable if the clipboard is empty.

When pasting an object, the new object is placed at a position similar to the original object. The 
new object is also automatically selected.

The Cut and Copy commands can place text or objects into the clipboard. The Paste command 
then places a copy of the current clipboard contents into the form, even when the clipboard 
contains text or objects that were copied or cut from another form. Text objects can be copied 
from other applications.

Shortcut
Toolbar:
Keys: Ctrl + V



Pen command (Form menu)

Modify line or border attributes for the selected object by using the Pen command in the Form 
menu or the object popup menu. This displays the Pen dialog box.



Pen command (Options-Defaults menu)

Settings assigned in the Options-Defaults-Pen dialog box are used to set defaults for all newly 
created line, rectangle, rounded rectangle and ellipse objects. Existing objects are unaffected.

All options are saved into the .INI file with the Options-Save Settings command.



Pen Dialog

Choose line thickness, style and color for Line, Rectangle, Rounded Rectangle and Ellipse 
objects. When accessed with the Options-Defaults-Pen menu, pen selections will only affect 
newly created objects.

The pen characteristics of an object can be altered after placement by using the Form Pen 
command, accessible from the main menu or the object popup menu. The dialog box title will 
not include "Defaults" when modifying an existing object.

Thickness:
Adjust line thickness. Accepted values are 1 through 10.
For non-solid lines, thickness is fixed to 1.

Style:
Adjust the appearance of the line. The Five choices available are:
Dash
DashDot
DashDotDot
Dot
Solid

Note that line thickness is fixed to 1 for any non-solid line.

Pen Color button
Access the Color dialog to choose from a given color set.



Pick List

Choose one of the items in this list for entry into the current field. You can select the item using 
a mouse click or arrow keys, or you can directly double-click on your selection.

The list presented here was created by the form designer to help during fillout. Whenever a pick 
list is present it is best to use it, as this leads to more consistent and accurate form fillout.



Preferences command (Options menu)

The settings assigned in the Options-Preferences dialog box are used to set defaults for 
program operations. These settings determine the way master forms and filled out forms 
function as you use them.

This is also where you can assign two custom view scale (25-300%) settings available in the 
View menu.

All options are saved into the .INI file with the Options-Save Settings command.



Preferences - All Tab

Sets defaults for various program operating parameters. You may temporarily change settings 
during the current session without saving them (Options-Save Settings). In this case, the 
original settings will be used next time you start SuperForms.

Custom Sizes:
The display scale you indicate here will be listed in the View pulldown menu.

Note:  Two of the view settings selectable from the View pulldown menu are user definable. 
Default settings for these custom view scales are defined by selecting Options-Preferences.

Four standard viewing scales are selectable from the pulldown menu and three of the most 
commonly used are available on the Toolbar. Two additional custom scales are user definable in
the Options-Preferences dialog box and are displayed in the View pulldown menu.

The two custom scales can be adjusted to settings you prefer. In the Options-Preferences dialog
box there are two fill in areas where you define the view settings. Accepted values are 25% 
through 300%.

Smooth Display:
The Smooth Display view option affects aesthetics only. It allows user control of a tradeoff 
between display flicker and speed. When off, the SuperForms display is faster, but objects can 
flicker as they are moved. When on, the display is slower, but no flicker occurs. The Smooth 
Display term represents a flicker-free display.

Personal preference and program usage will dictate this setting. Turning off Smooth Display 
during form design allows faster object movement. During fillout, the difference is less 
noticeable and less beneficial.

Color Correct Display:
This option only applies to color images. Windows allows each program control over a single 
system-wide palette of colors. When switching from FormPower to another program, this palette
can change to reflect the other program's specific requirements. When changing back to 
FormPower, if the palette was changed in the other program, a possibly time consuming color 
correction is done. This color correction on return to FormPower is not performed when this 
option is off. This can cause color images to appear color-distorted. In any case, color printouts 
will be unaffected.

See Also

Main Tab
Fillout Tab
Master Tab



Preferences - Fillout Tab

Sets defaults for various program operating parameters. You may temporarily change settings 
during the current session without saving them (Options-Save Settings). In this case, the 
original settings will be used next time you start SuperForms.

Display coordinates:
The position of the Pointing Device (mouse) cursor will be displayed on the Status bar while in 
fill out mode.

Tab between fields:
When ON, the Tab key will move data entry to the next field, and the Shift+Tab key will move 
data entry to the previous field.
Shift+Enter is always available to move data entry to the previous field. Enter always moves to 
the next field. For multi-line fields, only from the bottom line will Enter move to the next field.

Toolbar:
Toggle On or Off the toolbar display that appears in the active form window. When entering data
into a filled-out form (.fof extension) the Fillout Mode toolbar is normally displayed.

See Also

Main Tab
All Tab
Master Tab



Preferences - Main Tab

Sets defaults for various program operating parameters. You may temporarily change settings 
during the current session without saving them (Options-Save Settings). In this case, the 
original settings will be used next time you start SuperForms.

Toolbar:
Toggle On or Off the main Program toolbar display that appears just below the pull down menu. 
This toolbar remains available for both form design and fillout operations.

Status Bar:
Toggle On or Off the Status Bar displayed at the bottom of the program's window. Information 
such as instant help lines, mouse coordinates, type of active form and keyboard toggles are 
displayed.

See Also

All Tab
Fillout Tab
Master Tab



Preferences - Master Tab

Sets defaults for various program operating parameters. You may temporarily change settings 
during the current session without saving them (Options-Save Settings). In this case, the 
original settings will be used next time you start SuperForms.

Display coordinates:
The position of the Mouse will be displayed on the Status bar while in design mode.

Remember drawing tool:
When OFF, once an object is placed after selecting a drawing tool, the tool is deselected and 
select mode will automatically activate. This is indicated by the mouse cursor changing from a 
crosshair to an arrow. However, this automatic drawing tool deselection can be cumbersome 
when placing multiple objects with the same tool.
When ON, the drawing tool is not automatically deselected, so another object of the same type 
can be immediately placed.

View Fields:
When OFF, fields are shown in design mode the same way they will be shown in fillout mode. 
This means that borderless fields will be completely invisible unless selected. In fillout mode this
is acceptable since the user will be using Enter or Tab to move to the next field. In design mode,
fields aren't always apparent, but they also will not clutter the master form.
When ON, fields are indicated with a black border wrapped around the field's name. This is 
probably most desirable when placing, moving and resizing fields.

Toolbar:
Toggle On or Off the toolbar display that appears in the active form window. When creating or 
modifying a master form (.frm extension) the Design Mode toolbar is normally displayed.

See Also

Main Tab
All Tab
Fillout Tab



Print command (File menu)

Use this command to print a form. Presents a Print dialog box, where you may specify number 
of copies, destination printer, and other printer setup options.

Note: Make sure your printer landscape or portrait setting corresponds to the size and type of 
your form.

Shortcut
Toolbar:
Keys: Ctrl + P



Print Dialog

The following options allow you to specify how and where the form is printed.

Printer:
This is the active printer and printer connection. Choose the Setup option to change the printer 
and printer connection.

Print Range: (Unsupported)
Specify the pages you want to print:
All        Prints the entire form.
Selection        Prints the currently selected text.
Pages        Prints the range of pages you specify in the From and To boxes.

Print Quality:
Select the quality of the printing. Generally, lower quality printing takes less time to print.
Available choices are:
High
Medium
Low

Copies:
Specify the number of copies you want to print for the above page range.

Collate Copies:
Prints copies in page number order, instead of separated multiple copies of each page.

Setup button
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Progress Dialog
A small dialog box showing progress is displayed while SuperForms is sending output to the 
printer. To abort printing, choose Cancel.



Print Preview Toolbar

Access the Print dialog box to start a print job.

Unsupported. Preview the next page.

Unsupported. Preview the previous page.

Unsupported. Preview one or two pages at a 
time.

Take a closer look at the page. (Make it bigger on
screen. Less of the page appears on screen with 
higher resolution.)

Take a larger look at the page. (More of the page 
appears on screen with lower resolution.)

Return from Print Preview to the main window.



Print Progress Dialog

The Printing dialog box is shown while SuperForms is sending output to the printer. The copy 
count and/or page number indicates the printing progress.

To abort printing, choose Cancel.



Print Setup command (File menu)

Use this command to select a printer and a printer connection. Presents a Print Setup dialog 
box where you specify the printer, its connection, and page orientation.



Print Setup Dialog

The following options allow you to select the destination printer and its connection.

Printer
Default Printer:
Choose the Default Printer as defined in the Windows Control Panel setting.
Specific Printer:
Choose a Specific Printer from one of the currently installed printers shown in the box. You may 
install other printers and configure ports (LPT1:, etc.) using the Windows Control Panel.

Orientation
Portrait:
This is normal orientation, where text is printed in the natural page orientation for the printer. For
example, an 8.5" wide by 11" high form would be printed in Portrait orientation on a LaserJet 
printer.
Landscape:
This orientation prints text 'sideways' on a page. For example, an 11" wide by 8.5" high form 
would be printed in Landscape orientation on a LaserJet printer.

Paper
Size:
Select the size of paper that the form is to be printed on.
Source:
Some printers offer multiple trays for different paper sources. Specify the tray here.

Options button
Displays a dialog box where you can make additional choices about printing, specific to the type
of printer you have selected. This dialog is presented by the selected printer's driver, which has 
full control over any printer-specific options. Printer drivers are provided by Microsoft and/or the 
printer manufacturer.

Network button
If you are connected to a network file server or workgroup, this button will activate your available
network services.
Note:    The single user version of SuperForms does not support network drive or services 
access, even though the Network button may be active.



Process Dialog

During fillout, field validations and calculations are carried out as appropriate, whenever the 
cursor moves into or out of a field. Since SuperForms provides various methods for changing 
field order and even bypassing fields, validations and calculations are repeated for all fields just 
prior to committing a form to use, such as when saving or printing it. However, there are 
situations where this repetition may not be appropriate, such as when saving a blank form.

This dialog allows for complete control over when revalidation and recalculation occur for all 
fields. When none of the fields make use of one or the other, that option is disabled. When the 
automatic processing is useful, or even when you're not sure, simply leave the options turned 
on. Otherwise, depending on the situation, you can turn revalidation or recalculation off.

At any time, use the Field Recalc All command to revalidate and recalculate all fields. This is 
identical to the processing described above. Fields are evaluated in normal left-right, top-down 
order.



The main window Title bar displays the SuperForms program name and the name of the active 
open form window.

The Form window Title bar indicates the name of the form. If the form is active, the title bar is 
highlighted.



Are you sure you want to clear the entire form?
Design mode

All objects in the form will be deleted.

Fillout mode

All fields will be cleared, and the master form will remain intact. When modifying an existing 
filled-out form, fields are only cleared in memory, leaving the file unchanged.

To prepare a new form to fill out, use the Edit-Fillout-New command.



Save option settings?
If you have modified any of the default settings in the Options menu, this message is a reminder
at program exit to save those changes. All defaults are saved in the SPF.INI file in your 
Windows subdirectory.



Rectangle command (Draw menu)

Rectangle Drawing tool. Activate by clicking on the Rectangle Toolbar button or by selecting the 
Draw-Rectangle command.

1) Position the mouse pointer to where you want to begin drawing.
2) Press and hold the left mouse button while dragging the mouse, thereby drawing a rectangle 
to the desired size.
3) Release the mouse button when done.

When the Snap-to-Grid option is selected in the Grid dialog box, the rectangle's corner points 
will "snap" to the nearest grid points.

See Also

Modifying Object Attributes and Moving and Resizing Objects

Shortcut
Toolbar:



Refresh command (View menu)

Use Refresh to update the screen at any time. This may be necessary when artifacts are 
caused by the Windows GUI or some video drivers during busy or complex editing sessions.

Shortcut
Keys: Ctrl + R



This number indicates the number of days between automatic reminders of probable 
SuperForms upgrades. The reminder message will reappear every 7-180 days (you select) in 
order to remind you that it may be time to get the latest version of SuperForms. This is not 
meant to nag you, but to gently remind you that we may have bigger and better things in the 
works.



Restore command (Control menu)

Use this command to return the active window to its previous size and position, before you 
selected the Maximize or Minimize command.



RoundRect command (Draw menu)

Rounded Rectangle Drawing tool. Activate by clicking on the Rounded Rectangle Toolbar 
button, or by selecting the Draw-RoundRect command.

1) Position the mouse pointer to where you want to begin drawing.
2) Press and hold the left mouse button while dragging the mouse, thereby drawing a rounded 
rectangle to the desired size.
3) Release the mouse button when done.

When the Snap-to-Grid option is selected in the Grid dialog box, the encompassing rectangle's 
corner points will "snap" to the nearest grid points.

Note
At the top right of the highlighted object there is a tab on the inside corner used to adjust the 
corner arch or roundedness of all four corners.

See Also

Modifying Object Attributes and Moving and Resizing Objects

Shortcut
Toolbar:



Save command (File menu)

Use this command to save the active form to its current name and directory. When you save a 
form for the first time, SuperForms displays the Save As dialog box so you can name your form. 
If you want to change the name and directory of an existing form before you save it, choose the 
Save As command. This command and its corresponding toolbar button will be greyed-out until 
the form has been modified.

Shortcut
Toolbar:
Keys: Ctrl + S



Save All command (File menu)

This command is used when there are two or more form windows open, one or more of which 
have been modified. Saves all open form files so you do not have to step through the save 
procedure for each and every one of them.



Save As command (File menu)

Use this command to save and name or rename the active form. SuperForms displays the Save
As dialog box so you can name your form.

To save a form with its existing name and directory, use the Save command.

Note: The single user, non-network version of SuperForms will not read-from or save-to a 
network drive.



File Save As Dialog

The following options allow you to specify the name and location of the file you're about to save:

File Name:
Type a new filename to save a form with a different name. A filename can contain up to eight 
characters followed by a period and then an extension of up to three characters. SuperForms 
adds the extension. You specify the file name in the Save File As Type box. Notice that the file 
listing is shaded to help prevent using a file name that is already used. This area of the dialog 
box shows a shaded listing of files in the current subdirectory. The listing may help in naming 
the new file if you've forgotten the filenames already used. You can indicate the type of files you 
want listed by clicking on the arrow in the section just below.

Directories:
This section indicates the current subdirectory. Use the section below to change to a different 
subdirectory. Change subdirectories by using the scroll bar or by double-clicking on a directory 
name. If a directory is not shown, it may be located as a subdirectory below the one just above 
the current subdirectory. Try double-clicking on a directory name that is one or two levels above 
the current subdirectory.

Save File as Type:
Click on the arrow to change the type of files listed in the section just above.
Available choices are:
Master Forms. (*.frm)
All Files (*.*)

Drives:
Click on the arrow to search for files on a different drive.

Network button
If you are connected to a network file server or workgroup, this button will activate your available
network services.
Note:    The single user version of SuperForms does not support network drive or services 
access even though the Network button may be active.



Save Settings (Options menu)

Your fine tuning of the Defaults and Preferences settings will remain effective only during the 
current session. If you want them to apply to future sessions, they must be saved. Temporary 
adjustments for the current SuperForms session may be made to the options settings for 
repetitive or similar tasks without the need to make those settings permanent. Individual objects 
can be modified using the Form pulldown menu or the object popup menu. You must decide 
whether or not you will need the new adjustments after you have ended this session.

See Also

Modifying Object Attributes



Fixed Views (View menu)

View scales allow for "zoom" in or out of any part of a form. "Scaling" or "zoom" is very similar to
how a zoom lens works on a camera. Zoom in and see it larger and in more detail, but see less 
of the form. Zoom out and see more of the form at a time, but see it smaller and in less detail. 
Depending on your screen resolution, a different scaling will be needed in order to view the 
entire form. If none of the standard scales match your needs, there are two user-definable 
scales. Print preview also allows for zooming in and out, but design and fillout features are 
unavailable there.

Four standard viewing scales are selectable from the View menu and three of the most common
ones are available on the Toolbar. Two additional custom scales are user-definable in the 
Options-Preferences dialog box and are displayed only in the View menu.

Shortcut
Toolbar:

Custom Views (View menu)

The two custom views can be adjusted to your preference. In the Options-Preferences dialog 
box there are two fields where you define the view scale settings. Acceptable values are 25% 
through 300%.



Select command (Draw menu)

Activate select mode. Click on the Select Toolbar button, or choose either the Edit-Select or 
Draw-Select commands. Once in select mode, an object is selected by placing the mouse 
cursor anywhere on the object and clicking the left mouse button. A selected object can be cut, 
copied, moved, resized or have its attributes modified.

Shortcut
Toolbar:



Select command (Edit menu)

When designing a master form, the Select command activates select mode. Click on the Select 
Toolbar button, or use either the Edit-Select or Draw-Select commands. Once in select mode, 
an object is selected by placing the mouse cursor anywhere on the object and clicking the left 
mouse button. A selected object can be cut, copied, moved, resized or have its attributes 
modified.

Shortcut
Toolbar:



Select All (Edit menu)

Selects all objects in the form. This is a quicker alternative to selecting each object individually.

Selecting all objects may be done in preparation for moving, copying, etc.



Send Mail (File menu)

Send a message via the resident email system, and sends the current form as an attachment. 
This is the same as if you were to send a message using your email program directly.

This menu item will not appear unless you have an email system that supports the Microsoft 
MAPI standard.



Size command (Control menu)

Click on the upper left corner (control tab) of the form window and select size.

Use this command to display a four-headed arrow so you can size the active window with the 
arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the 

pointer to the border you want to move.
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the 

window.



Window Size

Size command (Control menu)

Use this command to display a four-headed arrow so you can size the active 
window with the arrow keys.

After the pointer changes to the four-headed arrow:

1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the 
pointer to the border you want to move.
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable when the window is maximized.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Status Bar

The status bar is displayed at the bottom of the SuperForms window. To display or hide the 
status bar, use the Status Bar command in the View menu.

The left area of the status bar (also know as micro-Help) describes menu items as you use the 
arrow keys to navigate through menus.

This area similarly shows “fly-by” messages that describe the toolbar buttons as the cursor 
passes over them.

Further to the right, two numeric values are displayed, representing the horizontal and vertical 
mouse position on the form relative to the upper-left corner. 

Another indicator will display "Master", or "Fillout" depending on the function mode you are in.

The far right area of the status bar indicates which of the following keys are set (check your 
keyboard for a light or other indication):

CAP The Caps Lock key is set.
NUM The NUM lock key is set.



Switch To command (Application Control menu)

Use this command to display a list of all open applications. Use this "Task List" to switch to or 
close an application on the list.

Shortcut
Keys: Ctrl + Esc

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:

Task List
Select the application you want to switch to or close.

Switch To
Makes the selected application active.

End Task
Closes the selected application.

Cancel
Closes the Task List box.

Cascade
Arranges open applications so they overlap and you can see each title bar. This option does not
affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap. This option does not affect 
applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



"TestDrive" refers to a fully functional version of SuperForms that is meant for evaluation of 
same, much like you test drive an automobile before you purchase it. Also, just like a test drive, 
the salesman usually comes along. So you may have to put up with occasional “commercials” 
asking you to purchase (a.k.a. regi$ter) the program.

The TestDrive edition of SuperForms is functionally identical to the full or registered version. 
However, only two forms may be opened simultaneously.

Regi$tering removes all TestDrive screens. Please feel free to “share” TestDrive editions ONLY 
of SuperForms with your associates.

Please help us keep the cost of software low by NOT SHARING registered versions of 
SuperForms with anyone within the limits of the license granted to legitimate purchasers by 
EZX.



For internal use only.



Text command (Draw menu)

Text Drawing tool. Activate by clicking on the Text Toolbar button, or by selecting the Draw-Text 
command.

1) Position the mouse pointer to where you want to begin drawing.
2) Press and hold the left mouse button while dragging the mouse, thereby drawing a rectangle 
to the desired size of the text area.
3) Release the mouse button when done.

Height of the text area is fixed to a multiple of the selected font height. When changing a font, 
be sure to also readjust the height of the text area.

When the Snap-to-Grid option is selected in the Grid dialog box, the encompassing rectangle's 
corner points will "snap" to the nearest grid points.

Once created, a text cursor will flash in the object on the form to indicate that text can now be 
entered. When done, the Enter key will end text entry.

To modify it after initial entry, double-click on the text.

See Also

Modifying Object Attributes and Moving and Resizing Objects

Shortcut
Toolbar:



Text command (Edit menu)

When a single text object is selected, this command will re-enter edit mode on that text. This is 
similar to what happens when a text object is created. In either case, when done editing the text,
press the Enter key or click on another object to finish editing.

Shortcut
Mouse: Double-click on 

text object



Text command (Form menu)

Modify text attributes for the selected object by using the Text command in the Form menu or 
the object popup menu.

See Also

Text dialog box
Font dialog box



Text command (Options-Defaults menu)

The settings assigned in the Options-Defaults-Text dialog box are used to set defaults for all 
newly created text and field objects. Existing objects are unaffected.

All options are saved into the .INI file with the Options-Save Settings command.



Text Dialog

Choose justification, margins, etc., for Text and Field objects. When accessed with the Options-
Defaults-Text menu, text selections will only affect newly created objects.

The text characteristics of any Text or Field object can be altered after placement by using the 
Form Text command, accessible from the main menu or the object popup menu. The dialog box 
title will not include "Defaults" when modifying an existing object.

Hint:  Double-click on an existing Text object to quickly change to text edit mode.

Justification:
Set the properties for any given text or field object to the Left, Center, or Right side of that area. 
Also, Full Justification will extend the text from left edge to right edge by adding proportional 
spacing between each word of the text or field object. Settings here are used for both Text areas
and Field objects.

Margins:
Use this section to adjust margin settings within Text and Field objects. Fine adjustments and 
character alignment are possible with this method.

Border:
Add a border around the Text or Field object.

Text Color button
Access the Color dialog box to choose from a given color set.



Tile command (Window menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.



Text Feed-Time (Edit menu) & Time (Field menu)

Quickly insert system Time into a field during data entry using Ctrl + T. Any text that may 
already be in the field will be overwritten. You will not be able to auto insert into the middle of a 
sentence or phrase.

The format for Auto Text Feed is controlled by the Windows Control Panel International settings.

Shortcut
Toolbar:
 Keys: Ctrl + T



To Back command (Form menu)

Use the To Back command when two or more objects overlap each other. If the one you want 
fully displayed is positioned under another, highlight the top object and use this command to 
place it behind all others.

Fields are treated differently than other objects when considering object overlap, therefore the 
To Front and To Back commands are unavailable for field objects.



To Front command (Form menu)

Use the To Front command when two or more objects overlap each other. If the one you want 
fully displayed is partially visible behind another object, highlight the partially hidden object and 
use this command to place it on top of the others.

Fields are treated differently than other objects when considering object overlap, therefore the 
To Front and To Back commands are unavailable for field objects.



Main Toolbar

The main toolbar is displayed across the top of the SuperForms main window, below the menu 
bar. It provides quick mouse access to the commands used most often. To hide or display the 
Main Toolbar, select the Toolbar option from the Options Preferences Main dialog tab.

In addition to the main toolbar, there are two types of Form Window Toolbars.

Toolbar - Design Mode
Displayed across the top of the active form's window while in design mode only. It provides 
quick mouse access to various commands that are unique to design mode.

Toolbar - Fillout Mode
Displayed across the top of the active form's window while in fillout mode only. It provides quick 
mouse access to various commands that are unique to fillout mode.

Click on any toolbar button for further explanation.

Toolbar:    Pulldown Menu: Hot Key:
Action:

File - New Ctrl + N
Create a new form. SuperForms displays the Form Layout dialog box to select various form 
attributes.

File - Open Ctrl + O
Open an existing form. SuperForms displays the Open dialog box, in which you can locate and 
open the desired file.

File - Save Ctrl + S
Save the active form or template with its current name. If you have not named the form, 
SuperForms displays the Save As dialog box.

Edit - Cut Ctrl + X
Selected objects or text can be removed by using the Cut toolbar button or the Edit-Cut 
command. The object or text is also placed in temporary storage on the Windows clipboard.

Edit - Copy Ctrl + C
Make a duplicate copy of the selection to the clipboard. Selected objects can be duplicated by 
using the Copy toolbar button or the Edit-Copy command.

Edit - Paste Ctrl + V
Insert the contents of the clipboard into the active form. For text, position the cursor to the 
desired place before pasting. Objects and text can be pasted by using the Paste toolbar button 
or the Edit-Paste command.



File - Print Ctrl + P
Presents a Print dialog box, where you may specify number of copies, destination printer, and 
other printer setup options.

Help - Contents F1
Displays the SuperForms Help Contents screen.

Context Help Shift + F1
Use the Context Help command to obtain help on a specific SuperForms command, icon or 
screen area.

View - Scale Three of the six most commonly used view choices.



Design Mode Toolbar
Displayed across the top of the active form's window while in design mode only. It provides 
quick mouse access to various commands that are unique to design mode. To hide or display 
this toolbar, select the Toolbar option from the Options Preferences Master dialog tab.

Click on any toolbar button for further explanation.

Toolbar:    Pulldown Menu: Hot Key:
Action:

Edit / Draw - Select Click on the Select Toolbar button, or use the Edit-Select or Draw-
Select commands.

Draw - Line Line Drawing tool.

Draw - Rectangle Rectangle Drawing tool.

Draw - RoundRect Rounded Rectangle Drawing tool.

Draw - Ellipse Ellipse Drawing tool.

Draw - Text Text Drawing tool.

Draw - Field Field Drawing tool.



Fillout Mode Toolbar

Displayed across the top of the active form's window while in fillout mode only. It provides quick 
mouse access to various commands that are unique to fillout mode. To hide or display this 
toolbar, select the Toolbar option from the Options Preferences Fillout dialog tab.

Click on any toolbar button for further explanation.

Toolbar:    Pulldown Menu: Hot Key:
Action:

Field - Help Ctrl + H
Display a field-specific Help screen created by the form designer.

Field - Pick Ctrl + P
Display field-specific Pick list created by the form designer.

Field - Date Ctrl + D
Place the current date into the field.

Field - Time Ctrl + T
Place the current time into the field.

Field - Calculate Recalculate the formula in the current field.

Field - Validate Validate this field's contents based on the form designer's criteria.



Troubleshooting
General Protection Fault Errors



Troubleshooting: General Protection Fault Errors
Problem: You receive an error message indicating that SuperForms has caused a General 
Protection Fault (GPF) Windows system error.

Solution: GPFs are very tricky things. Usually they happen when resources are low (has 
nothing to do with memory installed), or possibly some other unstable program is running or has
been shut down and it has left open some files or other system resources.

Your CONFIG.SYS file should contain the following statements:
      FILES=80
      stacks=16,512
      SHELL=C:\DOS\COMMAND.COM C:\DOS\ /e:1024 /p    (do not change if already set.)
      DOS=HIGH    or DOS=UMB      (do not change if already set.)

The 'SHELL=' path may need to be changed for your system.

It is possible that GPFs could be caused by running out of room on the system stack heap. 
Increasing the files count and stack resources will probably solve the failure. See the DOS 
documentation for the STACK command for more information. Try running SuperForms as the 
only open program in Windows. Check the Startup group for any programs that load 
automatically.



Undo Delete Command (Edit menu)

Use this command to reverse the last delete, if possible.

Shortcut
Keys: Ctrl + Z      or

Alt + Backspace



Using Help command (Help menu)

Use this command for detailed instructions about how to use the Windows Help program.



We are constantly striving to improve the operation, versatility and user productivity of 
SuperForms for Windows. You may be interested in the latest program enhancements. You may
also wish to license multiple copies and/or a Local Area Network version.

Call EZX/SSW at 1.713.280.9900 (FAX: 713.280.0099) for information concerning new features,
benefits, etc.. Be sure the registration card has been properly filled out and mailed in to us. As a 
courtesy to registered users we offer special upgrade pricing on all versions of FormPower.

If you have a registered version of FormPower, be sure the registration card has been properly 
filled out and mailed in to us.
EZX Corp., PO Box 58177 - SPF96f, Webster, TX 77598-8177 USA

Special versions of FormPower/FillPower specifically tied to custom developed forms, are the 
“engines” that drive products like ExportPower™, PackageTrakker™, YourForms™, 
WinDD250™, WinSF171™, AnyPower™, MedPower™, ExpensePower™, etc. Call for details.

Should you require a special “sub-published” edition of FormPower/FillPower customized for 
you and your special form or application, contact EZX at the address and numbers below. 
Developers and VARs only, please.

For FAX-back information, you may call our FAX-on-Request systems 24 hours a day at 
1.713.280.8300.



A reminder for SuperForms TestDrive edition users that the program was developed at least one
year ago. Certain features may now be completely disabled, but none of your forms will ever be 
lost. You just will not be able to save any new changes. THIS VERSION OF SuperForms HAS 
EXPIRED!

Call for latest information concerning product version, pricing and added features. We accept 
Visa, MasterCard, Discover and American Express via the phone.

We are constantly striving to improve the operation, versatility and user productivity of 
FormPower for Windows. You may be interested in the latest program enhancements. You may 
also wish to license multiple copies and/or a Local Area Network versions.

Call EZX/SSW at 1.713.280.9900 (FAX: 713.280.0099) for information concerning new features,
benefits, etc.

If you have a registered version of FormPower, be sure the registration card has been properly 
filled out and mailed in to us.
EZX Corp., PO Box 58177 - SPF96c, Webster, TX 77598-8177 USA

Special versions of FormPower/FillPower specifically tied to custom developed forms, are the 
“engines” that drive products like ExportPower™, PackageTrakker™, YourForms™, 
WinDD250™, WinSF171™, AnyPower™, MedPower™, ExpensePower™, etc. Call for details.

Should you require a special “sub-published” edition of FormPower/FillPower customized for 
you and your special form or application, contact EZX at the address and numbers above. 
Developers and VARs only, please.

For FAX-back information, you may call our FAX-on-Request & Voicemail systems 24 hours a 
day at 1.713.280.8300.



Vertical Scroll bars

Vertical Scroll bars are positioned on the right side. Scroll bars are displayed at the right and 
bottom edges of the form window when the form exceeds the size of that window. The scroll 
boxes inside the scroll bars indicate your vertical and horizontal view of the form. You can use 
the mouse to bring other parts of the form into view.



The form orientation does not match the printer orientation
setting. Continue printing?
A form's orientation is chosen by the designer with the Form Layout command. The File Print 
Setup command allows setting of various print options, among them is orientation. When these 
orientations don't match exactly, this message results. It is possible to continue printing, but the 
resulting printout will probably be unusable.

Other problems can result when the paper size used in the printer does not match the size 
specified for the form. However these problems are less likely and probably more obvious.



Save this form before continuing.
Design mode

Changes are about to be made to the form in memory, so the current form must be saved. 

Fillout mode reads in the form in a specific manner to provide access to field data entry areas 
only. When completed, the form in the active window (memory) is saved to a separate file with a
.FOF file extension. With this method the master form is not modified and is available for future 
entries containing different data that may be saved to a different .FOF file.

Once saved, data entry fields in .FOF files may be modified at any time. This method may be 
used to clone new filled-out forms that may contain repetitive data.

Remedy

Save the form, then reselect the command.



What's New
in the PRO version.

• TWAIN-compliant scanner support via File-Scanner commands - allows FormPower PRO to 
directly 
import pre-printed forms or images. Import your most often used forms, set the image to be non-
printable, 
add data entry fields and save form.

                                            This also applies to scanner-acquired images.

• Added Full Zero Suppression to calculated numerical fields.

FormPower Release 96c - Released March 1996

• Edit-Insert Graphic and Edit-Change Graphic - BMP and DIB graphic files can now be directly 
utilized in a form without OLE overhead.
• Added Full Justification to Text attributes option.
• Color correct display option added to the Options-Preferences All tab.
• Improved support for larger OLE images.

FormPower Version 2.0 Release 95k - Released November 1995

“PRO” features include:
• Extensive on-line help and MANUAL with BROWSE, TEXT SEARCH and PRINT. The Help's 
powerful features (not available in “regular” Windows help files) will allow you to find any topic or
phrase quickly. You will also be able to print any group of topics on demand. The unique “tree” 
structure gets you to your information fast. You'll NEVER be without your manual again!
• Calculations - robust and “better than a spreadsheet”. 50+ field-oriented mathematical and 
logical functions are supported.
• Field Types: Character, Numeric, Date or Logical.
• Automatic field options include: Number (great for incrementing invoices, reports, etc.), Date, 
Time, Calculated and Remember. Override enable/disable is available too.
• Numeric field formatting with selectable number of visible digits and leading/trailing zero 
suppression.
• Field Pick Lists allow annotated data entry selections for real “no brainer” fill-out/in.
• Field Help allows the forms designer to input custom help for each field of the form - kind of 
like having the expert looking over the filler's shoulder.
• Field Validation assures proper data entry. Override (with customizable error message) is 
allowable if there are errors.
• Built-in support for MAPI (mail application programming interface) compatible E-mail 
(Electronic Mail).
• Enhanced dialog boxes with Tab select groups.
• Multiple Object Selection for fast movement and duplication of entire groups of objects.

New features in Version 1.30 Release 95h include:
• Support for international measurements and paper sizes.



    Window's international settings are monitored and the appropriate defaults 
    are used. (ISO paper sizes and metric measurements, for instance)
• Unlimited character size for text objects. (Old limit was 256 characters.)
• Improved OLE functionality.
• Date and Time feed.
• Multiple copy printing.
• Graphics placement/sizing is faster.



Title Bar

The title bar is located along the top of a window. It contains the name of the application and the
active form.

To move the window, drag the title bar to the desired position.

Note: You can also move dialog boxes by dragging their title bars.

A title bar may contain the following elements:
 Application Control menu button
 Form Control menu button

 Maximize button
 Minimize button
 Name of the application
 Name of the form
 Restore button



YourForms PRO for Win Home/Office Inventory & Forms Developer!

YourForms PRO for Windows 3.1+ Home/Office Inventory Application. With YFP End-user or 
Developer's Editions We/You will be able to develop your own automated forms applications 
WITH NO PROGRAMMING. Sell them or give them away without any further fees! WYSIWYG, 
icon forms launch, multiple open forms, protected fields, more. All Win printers. EZX Corp. 713-
280-9900    FAX:0099 BBS:8180 Tech:0080

* Doing Windows forms?

* Need to distribute a high quality custom FormPower PRO<tm> application?

* Read on!    If not, please forward to someone who does. They'll be glad you did!

    Y O U R F O R M S      P R O ™
* Turns your form (AnyForm™) into your own "product" in minutes.

* Do you have a form (or forms) that you or your company fills out often, far and wide?

 Do your clients, customers, employees, or sales force cry out for automation?

* How would you like your own form(s) immortalized and distributed (if you wish) royalty free?

* Rejoice, YourForms PRO for Windows is here! ! ! !

- For a reasonable fee, EZX will design your custom form(s) to your satisfaction, and mate it 
(them) to a Fill-Only version of FormPower PRO™ called YourForms PRO™ that is customized 
for you.

 [FYI: FormPower PRO is a general purpose FORMS PROCESSOR for Windows 3.1x & 95 that
allows you to create, fill-in, fill-out, revise, file all kinds of forms. See detailed description below.]

- EZX will configure a custom installation routine, Windows program group, and icons tied to 
your form(s). This will make installation and use a certified "no-brainer".
- And the best part of it all is the purchase of a "YourForms PRO" license entitles you to 
distribute the program with your form to anyone, anywhere, without any additional fees or 
royalties.
- EZX "locks" the form(s) to your edition of YourForms/FillPower so that no-one else can access 
them, or make any unauthorized changes.
- YourForms PRO is available in single-machine use and network (LAN) versions.
- EZX will name the header on the program anything you wish, and have rights to.
- For an example of "YourForms PRO" type applications, see EZX's ExportPower, WinDD250 
(Govt Form), MedTrakker, ExpenseTrakker, KidTrakker, etc. custom applications.
- For more details, and a price quote, give us a call or FAX. We'll respond immediately to 
discuss your application(s) in detail.
- We can usually turn around you custom order in less than a week.

- Contact Edward Marion at
    Voice:713-280-9900
    FAX:713-280-0099
    BBS:713-280-8180 (TestDrive and Catalog files available.)



    Tech:713-280-0080 (9:00am - 4:00pm      Central      M - F)
    Internet: ezx@cris.com    or    EZXHOU@AOL.COM

    EZX Corporation
“The Forms Automaton Company”
    403 E. NASA Rd., Suite 377
    PO Box 58177
    Webster (Houston), TX 77598-8177    USA

Pricing for YourForms PRO End User Edition

* EZX does all the work and gives you an installable diskette, ready to go.

* The first form, program and setup is $CALL (single machine) or $CALL (LAN).

* Each additional form page at the time of initial purchase is $CALL ($CALL later).

* If you want a "TestDrive" (DEMO) edition of your program, add $CALL at time of
    original purchase or $CALL later.

* Pricing includes all setup, design, scanning, shipping, and one year of
    priority technical support.

* Contact Ed Marion at    Voice:713-280-9900    FAX:713-280-0099.
    Internet: ezx@cris.com    or    EZXHOU@AOL.COM

more.....

QUESTION:
Are you a developer or MIS professional who would like to create automated forms applications 
for your customers, company, employees, reps., etc.?        Ask about the Developer's Edition of 
YourForms PRO. (See below.)

* Become a Forms Software Developer/Publisher

* ABSOLUTELY NO PROGRAMMING SKILL OR KNOWLEDGE IS REQUIRED.

* The ONLY ability you need to become a developer is to be able to design or scan forms. If you
are familiar with Windows word processors and DTP your first form will take an hour or less.

* Congratulations, you're now a developer!

* With YourForms PRO Developer's Edition, You will be able to develop your own 
YourForms/FillPower type applications and sell them (or give them away, or use them in your 
company) without any further royalties or fees. You can change the name on the Program 
Group to suit the application.

* Cost is a mere $CALL one time fee and includes:
    - Your own custom coded version of FormPower PRO, which will create and/or revise forms 
designed by you and only you.
    - A custom version of FillPower PRO (both single machine and LAN editions) which you will be



able to distribute with forms you create to your clients or within your organization. It will fill-out 
only your forms.
    - A custom "TestDrive" version of FillPower PRO that will enable you to distribute functional 
"demos" or "TestDrives" of your creations.
    - A Windows based installer that will allow you to make custom program groups, "no-brainer" 
installation, titles, icons, etc.
    - One year of priority technical support.
    - Reduced price applications development consulting.

* In essence, you will be in "competition" with us. But, you will be able to service your customers
directly with backup from us, should you need it.

- Contact Edward Marion at Voice:713-280-9900 FAX:713-280-0099 BBS:713-280-8180 
Tech:713-280-0080
    Internet: ezx@cris.com    (http://www.cris.com/~ezx)    or      EZXHOU@aol.com    
(http://home.aol.com/EZXHOU)



Draw Menu commands
The Draw menu offers the following commands:

Line Draw lines vertically, horizontally, or angled.
Rectangle Draw squares or rectangular shapes.

RoundRect Draw squared and rectangular shapes with 
rounded corners.

Ellipse Draw circles or stretch the circle to any horizontal
or vertical length. A stretched circle is an ellipse.

Text Create a text object within the form.
Field Add data entry fields in specific locations on the 

form.
Select Enables Select drawing mode.



Edit menu commands (Design Mode)
The Edit menu offers the following commands:

Select Enables Select drawing mode.
Cut Deletes data from the form and moves it to the 

clipboard.
Copy Copies data from the form to the clipboard.
Paste Pastes data from the clipboard into the form.

Delete Removes the currently selected text or object.
Text Edit selected text object.

Undo Restores the last deleted text or object.
Text Feed-Time Place today's date into fillout field in form
Text Feed-Date Place current time into fillout field in form

Clear All Clears all text or all objects.
Select All Multi-Object manipulation.



Edit menu commands (Fillout Mode)
The Edit menu offers the following commands:

Cut Deletes data from the form and moves it to the 
clipboard.

Copy Copies data from the form to the clipboard.
Paste Pastes data from the clipboard into the form.

Delete Removes the currently selected text or object.
Undo Restores the last deleted text or object.

Text Feed-Time Place today's date into fillout field in form
Text Feed-Date Place current time into fillout field in form

Clear All Clears all text or all objects.



Field menu commands
The Field menu offers the following commands:

Date Place today's date into fillout field in form
Time Place current time into fillout field in form



File menu commands (Design Mode)
The File menu offers the following commands:

New Creates a new form.
Open Opens an existing form.
Fillout Fillout a form that contains data entry fields.
Close Closes the active form window.
Save Saves an opened form using the same file name.

Save As Saves an opened form to a specified file name.
Save All Saves all modified forms that have not yet been 

saved to disk.
Print Prints a form.

Print Setup Selects a printer and printer connection.
File 1, 2, 3, 4 List of the four most recently opened forms.

Exit Exits SuperForms.



File menu commands (Fillout Mode)
The File menu offers the following commands:

New Creates a new form.
Open Opens an existing form.
Fillout Fillout a form that contains data entry fields.
Close Closes the active form window.
Save Saves an opened form using the same file name.

Save As Saves an opened form to a specified file name.
Save All Saves all modified forms that have not yet been 

saved to disk.
Print Prints a form.

Print Setup Selects a printer and printer connection.
File 1, 2, 3, 4 List of the four most recently opened forms.

Exit Exits SuperForms.



Form menu commands
With an object is selected, the Form pulldown menu will allow changes to that particular object 
only. Modifications do not affect any of the other objects on the form. Grid and Form Layout 
options apply on a form-wide basis.

Text Text margins, justification, etc.
Font Font name, size, etc.
Pen Line/border type and thickness.

Brush Rectangle, RoundRect, and Ellipse backgrounds.
To Front Places object into foreground.
To Back Places object into background.

Grid Spacing, ON-OFF, Snap to
Form Layout Adjust form output size.



Help menu commands
The Help menu offers the following commands, which provide you assistance with SuperForms:

Contents Displays the help Table of Contents.
Overview Displays a quick SuperForms overview.

Using Help Provides general instructions on using help.
About Displays the version number of SuperForms.



Options menu commands
The Options menu offers the following commands which enable you to set default operating 
parameters for various features of SuperForms.

Defaults-Text Attributes, color
Defaults-Font Font, size, attributes, color
Defaults-Pen Thickness, style, color

Defaults-Brush Style, color
Defaults-Grid Spacing, ON-OFF, Snap to

Defaults-Form Layout Adjust form output size.
Preferences Program features.

Save Settings Saves settings after adjusting program 
defaults



View menu commands
The View menu offers the following commands:
View Scaling commands:

100 % View at full size..
75 % View at 75% of full size.
50 % View at 50% of full size.

200 % View at twice full size.
Custom % User definable view scale.
Custom % User definable view scale.

Refresh Updates the screen.



Window menu commands
The Window menu offers the following commands, which enable you to arrange multiple form 
windows within the main SuperForms program window:

Cascade Arranges windows in an overlapped fashion.
Tile Arranges windows in non-overlapped tiles.

Arrange Icons Arranges icons of minimized windows.
Close All Close all opened form widows.

Window 1,2, ... Activates specified window.



The SuperForms program mode that allows creation and modification of Master Forms.



A SuperForms feature that creates objects. To place an object, first select a drawing tool, then 
position the mouse pointer to where the top leftmost point of the object will be and press the left 
mouse button. Then continue to hold the left mouse button and drag the mouse pointer to the 
bottom rightmost point of the object. Finally, release the left mouse button. If snap-to-grid is on, 
the object's end points will automatically move to the nearest grid points.



A specific type of form, created with SuperForms from a Master Form. A unique Fillout Form file 
exists for each form that is filled out. All Fillout Form files have an extension of .FOF.



The SuperForms program mode that allows creation and modification of Fillout Forms.



A format contained in a file, which specifies how data is to be presented on the screen or printer.
Forms can contain data fields, fixed text, printing attributes and graphics.



A specific type of form created by SuperForms in design mode. A Master Form represents a 
blank form, to be copied and filled out time and time again. All Master Form files have an 
extension of .FRM.



The basic unit of a form. An object is created by a drawing tool in design mode, and is saved 
into a Master Form. Objects have attributes, and can be modified in various ways.



OLE is an acronym for Object Linking and Embedding. In short, OLE allows an object created 
by an OLE server (such as Paint, Excel, etc.) to be embedded into an OLE client application, in 
this case SuperForms. This very powerful feature allows placement of graphics, sound, video or
other objects onto a SuperForms form.



In design mode only, to access this menu move the mouse pointer over an object and click the 
right mouse button. Continue to hold the button until you make a selection from the menu.






